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IS COMMUNICATIONSoduct Name> Quick User’s Guide

About This Document
This manual is intended for administrators and users of the AXIS 215 PTZ 
Network Camera, and is applicable for software release 4.40. Previous 
experience of networking will be of use when installing and using this 
product. Some knowledge of UNIX or Linux-based systems would also be 
beneficial, for developing shell scripts and applications. Later versions of this 
document will be posted to the Axis Website, as required. 

Safety Notices Used In This Manual
Caution! - Indicates a potential hazard that can damage the product.
Important! - Indicates a hazard that can seriously impair operation. 
Do not proceed beyond any of the above notices until you have fully 
understood the implications.

Intellectual Property Rights
Axis AB has intellectual property rights relating to technology embodied in 
the product described in this document. In particular, and without limitation, 
these intellectual property rights may include one or more of the patents 
listed at http://www.axis.com/patent.htm and one or more additional patents 
or pending patent applications in the US and other countries.  
This product contains licensed third-party software. See the menu item 
“About” in the product’s user interface for more information. 
This product contains source code copyright Apple Computer, Inc., under the 
terms of Apple Public Source License 2.0 (see 
http://www.opensource.apple.com/apsl/).  
The source code is available from: 
http://developer.apple.com/darwin/projects/bonjour/

Legal Considerations
Camera surveillance can be prohibited by laws that vary from country to 
country. Check the laws in your local region before using this product for 
surveillance purposes.

Electromagnetic Compatibility (EMC)
Note:  
To comply with limits in Class B, use one of the following accessories when 
connecting I/O cables: 
 
20291 ACC FERRITE SPLIT SNAP IN EUR
20292 ACC FERRITE SPLIT SNAP IN US 
 
USA - This equipment generates, uses, and can radiate radio frequency 
energy and if not installed and used in accordance with the instruction 
manual, may cause interference to radio communications. It has been tested 
and found to comply with the limits for a Class B computing device pursuant 
to Subpart B of Part 15 of FCC rules, which are designed to provide 
reasonable protection against such interference when operated in a 
commercial environment. Operation of this equipment in a residential area is 
likely to cause interference, in which case the user at his/her own expense 
will be required to take whatever measures may be required to correct the 
interference. Shielded cables should be used with this unit to ensure 
compliance with the Class B limits.
Canada - This Class B digital apparatus complies with Canadian 
ICES-003. 
Europe  - This digital equipment fulfills the requirements for 
radiated emission according to limit B of EN55022:1998, and the 
requirements for immunity according to EN55024:1998 residential, 
commercial, and light industry.
Japan - This is a class B product based on the standard of the Voluntary 
Control Council for Interference from Information Technology Equipment 
(VCCI). If this is used near a radio or television receiver in a domestic 
environment, it may cause radio interference. Install and use the equipment 
according to the instruction manual.
Australia - This electronic device meets the requirements of the Radio 
communications (Electromagnetic Compatibility) Standard 1998 AS/NZS 
3548.

Liability
Every care has been taken in the preparation of this manual; Please inform 
your local Axis office of any inaccuracies or omissions. Axis 
Communications AB cannot be held responsible for any technical or 
typographical errors and reserves the right to make changes to the product 
and manuals without prior notice. Axis Communications AB makes no 
warranty of any kind with regard to the material contained within this 
document, including, but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose. Axis Communications 
AB shall not be liable nor responsible for incidental or consequential 
damages in connection with the furnishing, performance or use of this 
material.

Trademark Acknowledgments
Ethernet, Internet Explorer, Linux, Macintosh, Microsoft, Mozilla, Netscape 
Navigator, UNIX, Windows, WWW are registered trademarks of the 
respective holders. Java and all Java-based trademarks and logos are 
trademarks or registered trademarks of Sun Microsystems, Inc. in the United 
States and other countries. UPnP is a certification mark of the UPnPTM 
Implementers Corporation. Axis Communications AB is independent of Sun 
Microsystems Inc.

Axis Customer Services
Should you require any technical assistance, please contact your Axis 
reseller. If your questions cannot be answered immediately, your reseller will 
forward your queries through the appropriate channels to ensure a rapid 
response. If you are connected to the Internet, you can:
• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database. Search by product, 

category, or phrases
• report problems to Axis support staff by logging in to your private support 

area
• visit the Axis Support Web at www.axis.com/techsup/
 
 

Safety Notice - Battery Replacement
The AXIS 215 PTZ uses a 3.0V CR2032 Lithium battery as the power supply 
for its internal real-time clock (RTC). This battery will, under normal 
conditions, last for a minimum of 5 years. Low battery power affects the 
operation of the RTC, causing it to reset at every power-up. A log message 
will appear when battery replacement is required. The battery should not be 
replaced unless required! If the battery does need replacing, please observe 
the following points:
Caution! Danger of Explosion if battery is incorrectly replaced.
Replace only with the same or equivalent battery, as recommended by the 
manufacturer.
Dispose of used batteries according to the manufacturer's instructions.

RoHS
This product complies with both the European RoHS directive, 
2002/95/EC, and the Chinese RoHS regulations, ACPEIP.

WEEE Directive
The European Union has enacted a Directive 2002/96/EC on Waste 
Electrical and Electronic Equipment (WEEE Directive). This 
directive is applicable in the European Union member states.
The WEEE marking on this product (see right) or its documentation 
indicates that the product must not be disposed of together with 
household waste. To prevent possible harm to human health 
and/or the environment, the product must be disposed of in an approved and 
environmentally safe recycling process. For further information on how to 
dispose of this product correctly, contact the product supplier, or the local 
authority responsible for waste disposal in your area. 
Business users should contact the product supplier for information on how to 
dispose of this product correctly. This product should not be mixed with other 
commercial waste.
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AXIS 215 PTZ - Accessing the camera 
Accessing the camera
The AXIS 215 PTZ can be used with most standard operating systems and supports Microsoft Internet Explorer 
6.x or later, Netscape 7.x or later and Mozilla 1.4 or later.

Note: To view streaming video in Microsoft Internet Explorer for Windows, you must set your browser to allow the AXIS Media Control (AMC) 
to be installed on your computer. The first time an MPEG-4 video stream is accessed, AMC also installs an MPEG-4 decoder for viewing 
the video stream. As a license is required for each instance of the decoder, the product administrator may have disabled the installation. 
If your workstation restricts the use of additional software components, the camera can be configured to use a Java applet for updating 
JPEG images. See the online help for more information.

Accessing from a browser
1. Start a browser (Internet Explorer, Mozilla, Netscape Navigator).

2. Enter the IP address or host name of the AXIS 215 PTZ in the 
Location/ Address field of your browser.

3. Enter the user name and password set by the administrator.

4. A video image is displayed in your browser.
Note: 

User functions in the AXIS 215 PTZ may have been customized to meet the specific requirements of the application. Consequently, 
many of the examples and functions in this section may differ from those displayed in your Live View page.

Setting the Password
1. When accessing the camera for the first time, the 

‘Configure Root Password’ dialog will be displayed 
on the screen.

2. Enter a password and then re-enter it, to confirm the 
spelling. Click OK.

3. Enter the User name: root 
Note: The default administrator user name root is 
permanent and cannot be deleted or altered.

4. Enter the password as set in step 2 above, and click 
OK. If the password is lost, the camera must be reset to the factory default settings. See page 34.

5. If required, click Yes to install the AXIS Media Control (AMC). You will need administrator rights on 
the computer to do this.

Accessing the camera from the Internet
Once installed, the camera is accessible on your local network (LAN). To access the camera from the Internet you 
must configure your router/firewall to allow incoming data traffic. For security reasons this is usually done on a 
specific port. Please refer to the documentation for your router/firewall for further instructions.

For more information, please visit the AXIS Internet Dynamic DNS Service at www.axiscam.net or, for Technical 
notes on this and other topics, visit the Axis Support Web at www.axis.com/techsup
 4 



AXIS 215 PTZ - Accessing the camera 
The Live View page
The following provides an overview of each button on the Live View page. If the AXIS 215 PTZ has been 
customized, the buttons will be displayed accordingly:

The Video Format drop-down list allows the video format on the Live View page to be 
temporarily changed. 

The two types of Output button each control the output directly from the Live View page. These are 
configured under Setup > Live View Config > Layout.

Pulse - click this button to activate the 
output for a defined period of time, e.g. 
to switch on a light for 20 seconds.

Active/Inactive - click these buttons to 
manually start and stop a connected device, 
e.g. switch a light on/off.

 

These buttons start/stop the Sequence Mode which automatically displays the view from preset 
positions at set intervals. Sequence mode is configured in Setup > PTZ Configuration > Sequence 
Mode.

The source list is used to select the preset positions already configured in the camera. These 
are created in Setup > PTZ Configuration > Preset Positions.

The Manual trigger buttons trigger an action directly from the Live View page. These buttons are 
configured under Setup > Live View Config > Layout. Click these buttons to manually start and 
stop events.

Use the Snapshot button to capture a snapshot of the image currently being displayed in the 
window. Right-click on the image to save it in JPEG format on your computer.

Area Zoom
This allows you to draw a box over a desired area to zoom into. In order to fine-tune the precision, Area zoom 
should be calibrated from Setup > PTZ Configuration > Advanced > Calibration.

To activate Area Zoom on the Live View page, click the Center mode button in the AMC viewer toolbar (in 
other Internet browsers choose PTZ > Center). Click in the image and while holding down the left mouse 
button, draw a square over the area you would like to zoom into.  
 
Pan/Tilt/Zoom controls
The Live View page also displays the Pan/Tilt/Zoom controls. These are enabled/disabled for specified 
users by the administrator under System Options > Security > Users > User List.

See also  Advanced - Limits, on page 21 for information on E-flip, proportional speed and Auto-flip 
(PTZ Configuration > Advanced > Limits.)
 5 



AXIS 215 PTZ - Accessing the camera 
The control panel
Click the Ctrl panel button to display the control panel, where the following settings 
are available:

• Auto focus - automatically adjusts the image focus.
• Backlight comp - enabling backlight compensation makes the subject clearer 

if the image background is too bright, or if the subject is too dark. 
• IR cut filter - when set to off, the camera will be able to “see” infrared light, 

e.g. at night, thus making the image clearer. The image is shown in black & 
white when the IR cut filter is off.

• Brightness - the image brightness can be adjusted using the +/- buttons, 
where a higher value produces a brighter image. Click the Reset button to 
revert to the values saved under Video & Image > Advanced > Camera.

• Shortcuts - these buttons can be configured to provide direct access to vari-
ous built-in auxiliary commands provided by the PTZ driver. See Advanced - 
Ctrl Panel on page 22.

Viewer controls
The default viewer to use for displaying moving images is selected from Setup > Live View Config > Layout.
The AMC viewer toolbar is available in Microsoft Internet Explorer for Windows only. See AXIS Media 
Control, on page 9 for more information. The AMC viewer toolbar displays the following buttons:

The Play/Stop buttons start and stop the live video stream.

The Snapshot button takes a snapshot of the currently displayed image. The Snapshot function and the 
target directory for saving snapshots can be configured from AMC (AXIS Media Control), which is 
available from the Windows Control Panel (Internet Explorer for Windows only).

Click the Start recording button to make an MPEG-4 recording. Click again to stop the recording. The 
recording is saved in the folder specified in the Recording tab in the AMC Control Applet. Only available 
if the recording button is enabled on the Live View Config page

Click the View Full Screen button and the video image will fill the entire screen area. No other windows 
will be visible. Press Esc (Escape) on the computer keyboard to cancel full screen view.

Click the Mute /Microphone buttons to switch the sound off and on. Only available if Audio is 
enabled.

Use the sliders to control the volume on the speaker and microphone. The volume can be set 
between 0 and 100. 

Navigation mode: 
Center will move the camera view to center on the position that was clicked. Also used for Area zoom. 
Joystick moves the camera in the direction indicated by a mouse click, relative to the center of the 
image. The further from the center the image is clicked, the higher the movement speed.
 6 



AXIS 215 PTZ - Accessing the camera 
PTZ Control Queue
Only one user can use the Pan/Tilt/Zoom controls at any one time. When multiple users are accessing the AXIS 
215 PTZ’s Live View page, they can be placed in the PTZ control queue and assigned a set period of time during 
which they have the use of the PTZ controls. Use the buttons to request or release control of the PTZ controls. 

The PTZ Control Queue is set up by the administrator under PTZ Configuration > Control Queue.

Server push (not available for Microsoft Internet Explorer)
With this method, the AXIS 215 PTZ maintains and controls an open HTTP connection to the browser and 
sends data as and when required, for as long as required. 

QuickTime
For use with MPEG-4 only. Note that in the settings for Video & Image > Advanced > MPEG-4, the Video 
object type must be set to Simple. 

Java applet
This alternative uses a Java applet to update the images in the browser. No download is required. Note that 
when this alternative is selected, external video sources will not be available on the live view page, and audio 
will be mono-directional only (to the client only). 

Still Image
Displays still images only. Hit your browser’s Refresh button to view a new image.
 7 



AXIS 215 PTZ - Video and Audio Streams 
Video and Audio Streams
The AXIS 215 PTZ provides several different image and video formats. The type to use depends on your 
requirements and on the properties of your network.

The Live View page in the AXIS 215 PTZ provides access to Motion JPEG and MPEG-4 video streams, as well as 
to single JPEG images. Other applications and clients can also access these video and audio streams/images 
directly, without going via the Live View page.

Video Stream Types

Motion JPEG
This format uses standard JPEG still images in the video stream. These images are then displayed and updated at 
a rate sufficient to create a stream that shows constantly updated motion.

The Motion JPEG stream uses considerable amounts of bandwidth, but also provides excellent image quality and 
access to each and every individual image contained in the stream.

Note also that multiple clients accessing Motion JPEG streams can use different image settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, providing high-quality video streams 
at less than 1 Mbit/s. 

The MPEG-4 standard provides scope for a large range of different coding tools for use by various applications 
in different situations, and the AXIS 215 PTZ provides certain subsets of these tools. These are represented as 
Video object types, which are selected for use with different viewing clients. The supported video object types 
are:

• Simple - sets the coding type to H.263, as used by e.g. QuickTime™. 
• Advanced Simple - sets the coding type to MPEG-4 Part 2, as used by AMC (AXIS Media Control) 
When using MPEG-4 it is also possible to control the bit rate, which in turn allows the amount of bandwidth 
usage to be controlled. CBR (constant bit rate) is used to achieve a specific bit rate by varying the quality of the 
MPEG-4 stream. When using VBR (variable bit rate), the quality of the video stream is kept as constant as 
possible, at the cost of a varying bit rate.

Notes: • MPEG-4 is licensed technology. The AXIS 215 PTZ includes one viewing client license. Installing addi-
tional unlicensed copies of the viewing client is prohibited. To purchase additional licenses, contact 
your Axis reseller.

• All clients viewing the MPEG-4 stream must use the same image settings.
 8 
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MPEG-4 protocols and communication methods
To deliver live streaming video over IP networks, various combinations of transport protocols and broadcast 
methods are employed.

• RTP (Realtime Transport Protocol) is a protocol that allows programs to manage the real-time transmission of 
multimedia data, via unicast or multicast.

• RTSP (Real Time Streaming Protocol) serves as a control protocol, to negotiate which transport protocol to 
use for the stream. RTSP is thus used by a viewing client to start a unicast session, see below.

• UDP (User Datagram Protocol) is a communications protocol that offers limited service for exchanging data 
in a network that uses the Internet Protocol (IP). UDP is an alternative to the Transmission Control Protocol 
(TCP). The advantage of UDP is that it is not required to deliver all data and may drop network packets when 
there is e.g. network congestion. This is suitable for live video, as there is no point in re-transmitting old 
information that will not be displayed anyway.

• Unicasting is communication between a single sender and a single receiver over a network. This means that 
the video stream goes independently to each user, and each user gets their own stream. A benefit of unicast-
ing is that if one stream fails, it only affects one user.

• Multicast is bandwidth-conserving technology that reduces bandwidth usage by simultaneously delivering a 
single stream of information to multiple network users. This technology is used primarily on delimited net-
works (intranets), as each user needs an uninterrupted data flow and should not rely on network routers.

AXIS Media Control 
The recommended method of accessing live video (MPEG-4 and/or Motion JPEG) and audio from the AXIS 215 
PTZ is to use the AXIS Media Control (AMC) in Microsoft Internet Explorer for Windows. This ActiveX 
component is automatically installed on first use, after which it can be configured by opening the AMC Control 
Panel applet from the Windows Control Panel. Alternatively, right-click the video image in Internet Explorer.

See the AXIS Media Control User’s Manual, available from the support pages on the Axis web site at: 
www.axis.com

How to stream MPEG-4
Deciding on the combination of protocols and methods to use depends on your viewing requirements, and on 
the properties of your network. Setting the preferred method(s) is done in the control applet for AMC, which is 
found in the Windows Control Panel. When this has been set, AMC will test all the selected methods in the 
specified order, until the first functioning one is found.

RTP+RTSP 
This method (actually RTP over UDP and RTSP over TCP) should be your first consideration for live video, 
especially when it is important to always have an up-to-date video stream, even if some images do get dropped. 
This can be configured as multicast or unicast. 

Multicasting provides the most efficient usage of bandwidth, especially when there are large numbers of clients 
viewing simultaneously. Note however, that a multicast broadcast cannot pass a network router unless the 
router is configured to allow this. It is thus not possible to multicast over e.g. the Internet. 

Unicasting should be used for video-on-demand broadcasting, so that there is no video traffic on the network 
until a client connects and requests the stream. However, as more and more unicast clients connect, the traffic 
on the network will increase and may cause congestion. Although there is a maximum of 20 unicast viewers, 
note that all multicast users combined count as 1 unicast viewer.

RTP/RTSP
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it is relatively simple to 
configure firewalls to allow RTSP traffic.

RTP/RTSP/HTTP
This method can also be used to traverse firewalls. Firewalls are commonly configured to allow the HTTP 
protocol, thus allowing RTP to be tunneled.
 9 



AXIS 215 PTZ - Video and Audio Streams 
Other methods of accessing the video stream
Video/images from the AXIS 215 PTZ can also be accessed in the following ways:

• If supported by the client, the AXIS 215 PTZ can use Motion JPEG server push to display video. This option 
maintains an open HTTP connection to the browser and sends data as and when required, for as long as 
required. 

• As single JPEG images in a browser. Enter e.g. the path: http://<IP address>/axis-cgi/jpg/image.cgi?resolu-
tion=CIF

• Windows Media Player. This requires AMC and the MPEG-4 decoder to be installed. The paths that can be 
used are listed below, in the order of preference.

• Unicast via RTP: axrtpu://<IP address>/mpeg4/media.amp
• Unicast via RTSP: axrtsp://<IP address>/mpeg4/media.amp
• Unicast via RTSP, tunneled via HTTP: axrtsphttp://<IP address>/mpeg4/media.amp 
• Multicast:  axrtpm://<IP address>/mpeg4/media.amp

Other MPEG-4 clients
Although it may be possible to use other clients to view the MPEG-4 stream, this is not guaranteed by Axis. 

For some other clients, e.g. QuickTime™ the Video Object Type must be set to Simple. It may also be necessary to 
adjust the advanced MPEG-4 settings.

To access the video stream from e.g. QuickTime™ the following path can be used:

rtsp://<IP address>/mpeg4/media.amp 

This path is for all supported methods, and the client will negotiate with the AXIS 215 PTZ to determine exactly 
which transport protocol to use.

Audio transmission methods
The audio stream can be accessed in the Live View page when viewing either Motion JPEG or MPEG. 

Using Motion JPEG
The basic transmission method of audio used in conjunction with Motion JPEG video streaming is transmission 
over HTTP. The video and audio streams are not synchronized when using Motion JPEG so the streams may be 
slightly out of sync. The latency in any stream should be low, but this will depend on the network infrastructure.

Using MPEG-4
When using MPEG-4, audio is streamed using the same protocol as the video stream.

When audio is transmitted using MPEG-4, the Axis product sends synchronization information along with the 
streams to the client that is performing the synchronization. 

Audio is streamed from the client to the server over HTTP when using Motion JPEG and MPEG-4.

Accessing the Audio Streams
In addition to accessing audio in the Live View page using AMC, audio from the Video Server can also be 
accessed in the following ways:

AXIS VAPIX API
You can read about accessing audio for the other protocols through the AXIS VAPIX API at 
http://www.axis.com/techsup

QuickTime/Windows Media Player
It is possible to use QuickTime and Windows Media Player to listen to the audio stream using the same methods 
to access video streams.
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Setup
The AXIS 215 PTZ is configured from the setup tools, which are available from the link in the web interface. The 
setup tools can be used by: 

• administrators, who have unrestricted access to all the Setup tools
• operators, who have access to the Video & Image, Live View Config and Event Configuration settings.
See the section on Security, on page 27 for more information on user access control.

Accessing the setup tools from a browser

Follow the instructions below:

1. Start the browser and enter the IP address or host name of the AXIS 
215 PTZ in the location/address field.

2. The Live View page is now displayed. Click Setup to display the 
Setup configuration tools.

Setup tools
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Video & Image settings
The following descriptions offer examples of the available features in the AXIS 215 PTZ. For details of each 
setting, please refer to the online help files .

To optimize the video images to your requirements, modify the following settings under Image Appearance:

Notes: All configuration of images and overlays will affect the performance of the AXIS 215 PTZ, depending on the usage and the available 
bandwidth. Please keep in mind the following when changing the image settings:

• Lower compression improves image quality, but generates larger files

•Color uses more bandwidth than Black & White

•Rotating the image will lower the maximum frame rate

•When using MPEG-4 as the video format, the compression setting will define the minimum compression level. The compression level will 
temporarily increase as and when required, i.e. when the bit rate approaches the maximum value as defined in the current profile@level 
combination.

• In certain conditions, the white balancing system will not operate effectively. See  Video Image Problems, on page 40 for more 
information.

You may need to click the Stop and Play buttons on the Live View page before the settings take effect.

Overlay Settings

overlay
 

Date & Time

image

Use these settings to include an image as an overlay, and/or 
the date and time, along with text of your own. 

See Overlay Image Settings below for instructions on how 
to upload an overlay image to the AXIS 215 PTZ.

Text overlays are included on one line at the top or bottom 
of the video image. Use text overlays in combination with 
OSDI (On-Screen Directional Indicator) on page 31 to aid 
the viewer in navigating the camera.

 

 

To set up

PTZ coordinates in

text overlay

Use #P #L to show the Preset and OSDI Zone name as text overlay

Video Stream

The video stream time can be set as Unlimited, or a maximum stream time per session in seconds, minutes or 
hours can be defined. When the set time has expired, a new stream can be started by refreshing the page in the 
Web browser. Note that the maximum video stream time does not apply to clients connecting via multicast.

To avoid bandwidth problems on the network, the frame rate allowed to each viewer can also be limited. Select 
either Unlimited or define a maximum frame rate per viewer.

For a preview of the image and overlay settings before saving, click Test. When you are satisfied with the 
settings, click Save.

• Resolution (including Aspect ratio correction and 4CIF de-interlacing)
• Compression • White balance
• Rotate image • Color setting
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Please use the online help files for more information.

Overlay Image Settings
An overlay image is an image included in the video image. This might, for example, be your own company logo. 
Follow these instructions to upload and use an overlay image:

1. Go to Setup > Video & Image > Overlay Image. 

2. To upload the image to the AXIS 215 PTZ, click the Browse button and locate it on your computer or 
server. 

3. Click the Upload button and follow the on-screen instructions.

4. The image is now available in the Use overlay image drop-down list.

5. Click Save.

6. Go to Setup > Video & Image and modify the parameters under Overlay Settings.

Overlay image requirements:

There are a number of limitations when using overlay images, such as the size and positioning of images. Please 
use the online help for more information.

Advanced settings
Camera - to optimize the lighting settings according to your requirements, modify the following settings under 
Lighting Conditions:

• Brightness - increase the value to brighten the image.
• Sharpness - increase the value to sharpen the image. A higher value will sharpen the image but also 

increase the image noise, especially in low lighting.
• IR cut filter - set the IR cut filter to On, Off or Auto. The IR cut filter can also be set to On, Off or Auto 

directly from the control panel on the Live View page.
• Backlight compensation - this setting is used to make the subject appear clearer against e.g. a bright 

background.
 

Low Light Behavior

These settings determine how the camera will function in low light conditions. Adjustments made here affect 
image quality and are basically a measure of how much noise to allow in images. Please use the online help 

for more information on each individual setting.

• Priority
• Exposure control
• Max exposure time
• Max gain

 

Image Settings

Image Formats Image Size

• Windows 24-bit BMP (full color)

• Windows 4-bit BMP (16 colors)

The height and width of the overlay image in 
pixels must be exactly divisible by 4.
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• Auto focus enabled (default setting)- Auto focus can also be set to On/Off directly from the control 
panel on the Live View page.

• Image freeze on PTZ - freeze the image either during pan, tilt, zoom movement or between preset 
positions only. Once the camera has reached its position, the current image is shown.

MPEG-4 Settings
The AXIS 215 PTZ supports the following different MPEG-4 
profiles and levels:

Advanced Simple Profile @ Level 3b Max bit rate = 1,5 Mbps 
ISMA compliant

Advanced Simple Profile @ Level 5 Max Bit rate = 8 Mbit/s

Level 5 is preferred if there is enough bandwidth available, 
as the image quality of the video stream will be better than 
if level 3 is used. The viewing client must support the profile 
used for the video stream otherwise the MPEG-4 stream can 
not be viewed.

Note: AXIS Media Control supports all the configuration possibilities 
available on this page.

The GOV structure can be set to either I or IP, which describes the type of images included in the video stream, 
as well as their internal order. The IP-structure generally sends the differences compared to the previous image 
and far fewer complete images, so this method uses much less bandwidth than the I-structure. The I-structure 
gives higher frame rates when using a high resolution, but requires more bandwidth.

The GOV length determines the sum total of P-images and I-images in a GOV. Setting the GOV length to a high 
value saves considerably on bandwidth. However there may be noticeable decay in the image at high values.

Note: GOV = Group of VOPs 
VOP = Video Object Plane 
Video Object Plane = image

Bit Rate Control

Limiting the maximum bit rate is a good way of controlling the bandwidth used by the MPEG-4 video stream. 
Leaving the Maximum bit rate as unlimited will provide consistently good image quality, but at the expense of 
increased bandwith usage whenever there is more activity in the image. Limiting the bit rate to a defined value 
will prevent excessive bandwidth usage, but images will be lost when the limit is exceeded.

Note that a maximum bit rate can be used for both variable and constant bit rates.

The bit rate type can be set as Variable Bit Rate (VBR) or Constant Bit Rate (CBR). VBR will adjust the bit rate 
according to the images' complexity, thus using a lot of bandwidth for a lot of activity in the image and less for 
lower activity in the monitored area.

Note: Depending on the amount of motion, the required bandwidth may increase by 1-15% for each frame. 

Video Stream

This parameter can be set to frame rate to increase the frame rate by 30% in 4CIF resolution. If the resolution is 
set to a value lower than 4CIF, the parameter should be set to bandwidth.

Profile@Level Properties
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Audio Settings
This section describes how to 
configure the basic audio settings 
for the AXIS 215 PTZ, e.g. set the 
communication mode and adjust 
the sound levels in the microphone 
and speaker.

Enable Audio

Check the Enable Audio checkbox 
to enable the audio functionality.

Audio Channels

There are two mono audio 
channels between the AXIS 215 
PTZ and other clients, one for 
receiving audio and one for 
transmitting audio. Each audio 
channel can be turned on or off, 
which means that there are four 
audio mode options that can be 
used.

Full-duplex mode means that you can transmit and receive audio (talk and listen) at the same time, without 
having to use any of the controls. This is just like having a telephone conversation. The only controls you may 
wish to use are the mute buttons to turn off the sound, and the sliders, to adjust the input/output volume levels. 
This mode requires that the client PC has a sound card with support for full-duplex audio. If your available 
bandwidth is 0.2 Mbit/s or less, it is recommended that you use Half-duplex mode instead.

Half-duplex mode also transmits and receives audio in both directions, but only in one direction at a time. This 
means that you must select when to receive or transmit audio using the push-to-talk button. To speak, press and 
hold the button (check that the microphone is not muted). When finished speaking, release the button. You will 
now be receiving audio from the other end of the connection. 

Note that the push-to-talk button is configured from AMC, see AXIS Media Control, on page 9. It is also possible 
to configure the Push-to-talk button so that it toggles between speaking and listening modes. Half-Duplex mode 
is best if you only have limited bandwidth available.

When you select Simplex - Network Camera speaker only mode, the speaker connected to the AXIS 215 PTZ 
will play audio, but no audio will be transmitted from the AXIS 215 PTZ to other web clients. This could be 
used, e.g. to provide spoken instructions to a person seen in the network camera. This mode requires you to use 
the push to talk button.

Simplex - Network Camera microphone only mode transmits audio from the microphone connected to the 
AXIS 215 PTZ to any web clients. It will not receive audio from any other web clients. This can be used in 
remote monitoring, web attractions etc., to provide live audio, as well as video, of a monitored situation.

When using half-duplex, the Send the sound from the active client to all other clients option transmits the 
audio signal from the client that is talking to all the other clients.

Audio Input

If there are problems with the sound input being too low or high, it is possible to adjust the input gain for the 
microphone connected to the AXIS 215 PTZ.

Source - select Microphone for an external microphone or Line for a Line in device, e.g. an audio mixer for 
multiple microphones or a microphone with a built-in amplifier.

Input sensitivity - set the sensitivity level of the audio input according to the following:
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If Microphone is selected - set the Input sensitivity to: 

• High if the connected microphone is an ordinary (unamplified) microphone, e.g. a computer mic or 
clip-on mic. 

• Low if the connected microphone has a built-in line amplifier. 
Enable microphone power - microphone power should only be used with an electret microphone without a 
battery. This setting should not be enabled when using a dynamic or battery powered microphone.

Input gain - volume control of the audio input. The Input sensitivity levels High and Low are volume settings 
made earlier in the audio path (see above).

Note: Low Input sensitivity should never be compensated by a high Input gain, as this may cause unwanted 
noise.

Encoding - select the digital audio encoding format to use.

Bit rate - depending on the selected encoding, set the required bit rate (audio quality). The higher the bit rate, 
the greater the bandwidth required.

Alarm level - event types in the AXIS 215 PTZ can be set to use this level as a trigger. Each individual event 
type can be configured to trigger if the sound level rises above or falls below the set value.

The alarm level can be set in the range 0-100%, where 0% is the most sensitive and 100% the least sensitive.

Audio Output

If the sound from the speaker is too low or high it is possible to adjust the output gain for the connected active 
speaker. 

When satisfied with the settings, click Save, or click Reset to revert to the previously saved settings.
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Advanced Audio Settings

The Advanced Audio settings allows you to tune the external microphone connected to the AXIS 215 PTZ to 
suit your environment.

Enable speech filter improves the sound quality when the microphone is placed close to the person talking and 
can also help reduce background noise. The filter cuts the lowest and the highest frequencies. The bypass 
frequency range is approximately 250Hz to 3700Hz (measured at -10dB cut-off break points).

Enable echo cancellation reduces acoustic echoing if sound from the speaker is captured by the microphone.

Noise canceling is a way of reducing the background noise when there is no useful audio present. A typical 
application could be that the camera is set up in a noisy environment, and you are only interested in hearing 
audio from the AXIS 215 PTZ when someone is speaking close to the microphone.

• Noise canceller attenuation

When the incoming sound is louder than the threshold, it will pass without any changes. When lower than the 
threshold, the incoming sound will be reduced by a certain attenuation factor. The threshold level should be set 
higher than the background noise, but lower than the useful audio. 

There is a trade-off between noise canceling and sound quality. In other words, increasing the noise canceller 
attenuation deteriorates sound quality. Adjust the threshold and the attenuation to an optimum by listening and 
changing the levels.
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Live View Config - Live View Layout 
These are the tools for determining the layout of the Live View 
page. The layout can be set in 3 ways:

• Use Axis look - the layout is unchanged.
• Use custom settings - modify the default page with your own 

colors, images etc. Click the Configure button and see the 
following page.

• Own Home Page - upload and use your own custom made 
page as the default web page. Click the Configure button 
and see the following page. 
  
  
  
  
 

Custom Settings

Upload Own Web Files
Your own web files, background picture, color etc. must first be uploaded to the AXIS 215 PTZ in order to be 
available for selection. Once uploaded, the files are shown in the drop-down list.

1. Enter the path to the file, e.g. a file located on your workstation or click the Browse button.

2. Select the user level for the uploaded file. Setting the user access level means that you have complete 
control over which pages can be viewed by which users.

3. When the path is shown correctly in the text field, click the Upload button.

All uploaded files are shown in the list in the lower section of the page. To remove a file, check the box provided 
next to it and then click the Remove button.

Modify the Axis Look
Adjust the settings under Modify the Axis Look, to change the background color, text color, background 
picture, banner, banner link, Logo, etc.

• To use your uploaded file, click the Own radio button and select the file from the drop-down list.
• To use an external file located somewhere other than in the AXIS 215 PTZ, click the External radio button 

and enter the URL to the file (applies to background picture, banner and logo).
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Show Setup link

Note that unchecking the box for Show setup link will remove the setup link from the camera’s Home Page. The 
setup tools will then only be accessible by entering the full setup address into the address/URL field of a 
browser, i.e.

Own Home Page
To use a previously uploaded web page as the default page, check the 
checkbox, select the page from the drop-down list and click OK.

Note: You can also add live video from the AXIS 215 PTZ to your own web site. For further 
information, please refer to  HTML Examples, on page 20.

User Defined Links 

Enter a descriptive name and enter the URL in the provided field. The link 
will appear on the Live View page.

User defined CGI links can be used to issue AXIS VAPIX API requests, 
e.g. PTZ commands.

Example:

1. Check Show custom link 1

2. Enter a descriptive name, e.g. CAM START.

3. Select the Use as cgi link radio button and enter the cgi link in the field:

4. Check Show custom link 2.

5. Enter a descriptive name, e.g. CAM STOP.

6. Select the Use as cgi link radio button and enter the cgi link in the field:

7. These links will appear in the web interface and can be used to control the PTZ camera.

For more information on the AXIS VAPIX API, see the Support / Developer pages on the Axis Website at 
http://www.axis.com

Action Buttons - these buttons can then be used to manually trigger and stop an event from the Live View page. 
See Event Servers, on page 23. 
The snapshot button allows users to take a snapshot of the video stream and save it on a computer.

Output Buttons - these buttons can then be used to manually start and stop an event from the Live View page, 
e.g. switch a light on/off:

• The Pulse button activates the port for a defined period
• Active/Inactive displays 2 buttons, one for each action (on/off)

Default Video Format - select default video format from the drop-down list. Check the box to enable video 
format selection from the Live View Page.

http://<ip address>/operator/basic.shtml

http://192.168.0.125/axis-cgi/com/ptz.cgi?continuouspantiltmove=-30,-30

http://192.168.0.125/axis-cgi/com/ptz.cgi?continuouspantiltmove=0,0

user defined link
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Default Viewer

When using Microsoft Internet Explorer (IE) for Windows, select your preferred method of viewing moving 
images. The options are: 

• AMC (ActiveX) - this is the best choice for fast image updating in Internet Explorer for Windows, but 
might not be possible on computers that have restriction on the installation of additional software.

• QuickTime - for use with MPEG-4 only, select this to use the QuickTime plug-in for Microsoft Internet 
Explorer.

• Java applet - this alternative uses a Java applet to update the images in the browser.
• Still Image - displays still images only. Hit the Refresh button in your browser to view a new image.

When using any other browser than Internet Explorer for Windows, select the appropriate method from the 
drop-down list for viewing images. The available options are similar to Internet Explorer except for Server 
Push. With this method, the camera maintains and controls an open HTTP connection to the browser and sends 
data as and when required for as long as required.

Please see the online help for more information.

Viewer settings

Show viewer toolbar - uncheck to remove the viewer toolbar from the Live View page.

Enable MPEG-4 decoder installation - enables/disables the installation of the MPEG-4 decoder included with 
AMC.

Show crosshair in PTZ joystick mode - enables/disables a red position indicator in the center of the image 
when the joystick navigation mode is selected.

Use PTZ joystick mode as default - enabling this sets the PTZ mode to joystick. The mode can temporarily be 
changed on the Live View page, but will default to joystick if selected.

Enable recording button - enables recording directly from the Live View page. The recording is saved in the 
folder specified in the Recording tab in the AMC Control Applet. Note that this button is only available when 
viewing with AMC.

HTML Examples
You can add live video from the AXIS 215 PTZ to your own web site. The camera can transmit a Motion JPEG 
stream to up to 20 simultaneous connections, although an administrator can restrict this to fewer. 

Select the preferred Video Format from the drop down list. The available options are Motion JPEG, MPEG-4 
using AMC and MPEG-4 using QuickTime. If MPEG-4 is set as the video format, note that a separate MPEG-4 
license is required for each viewer.

The Motion JPEG selection has additional settings for Image Type, Image size and other optional settings to 
configure the video stream to suit your Web page. Click Update once satisfied. 

The camera generates the required source code for your configuration. Copy this code and paste it into your own 
Web page code.

External Video
An external video source is a source originating from some other Axis device on the network. The images from 
these sources can be displayed just as if they were produced by the AXIS 215 PTZ.

The External Video Source list shows all of the external video sources currently configured. The information 
displayed is the name of the source and the path to the video stream. Up to 20 external video sources can be 
configured. Please see the online help for more information.
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PTZ Configuration

Preset Positions
A preset position is a pre-defined camera view than can quickly and easily be viewed.

From Preset Position Setup, use the Pan, Tilt and Zoom (PTZ) controls to steer the camera to the required 
position. When satisfied with the camera's position, enter a descriptive name. This camera position is then saved 
as a preset position. 

The AXIS 215 PTZ will take the exact position when the preset's 
name is selected from the Preset positions drop-down list. Preset 
positions can be selected in Live View, from events and in 
Sequence mode.

One position can be set as the Home position, which is readily 
accessible by clicking on the Home button in both the Preset 
Position Setup window and the Live View window. The 
position's name will have (H) added, e.g. Office Entrance (H).

Sequence Mode
The Live View page can be configured to rotate through the selected preset positions, in a set order or randomly.

Select the desired preset positions and enter the time to display each position. Click Save.

The Sequence buttons will appear on the Live View page to enable the viewer to start and stop the 
sequence mode.

OSDI Zones
On-Screen Direction Indicator Zones are areas that you define with coordinates and a descriptive name. These 
zones can then be included in the Image text to aid the viewer in navigating the camera.

The camera uses the coordinates of the center of the image to set the lower left and upper right zone areas. First 
navigate where you would like the most lower left point of the OSDI Zone to be located. The coordinates are set 
by clicking on the Get button. Proceed to where the upper right point of the zone should be located and click on 
the corresponding Get button. Give the zone a descriptive name and go to Overlay Image Settings, on page 13 
for information about including the name of OSDI Zone in the Image text.

Advanced - Limits
Define the pan, tilt and zoom limits for the AXIS 215 PTZ. Movements to the left and right, up and down can be 
restricted to narrow the area under surveillance.

Note: The image is automatically flipped over (E-flip) e.g. when the target moves under the camera and then 
moves on. In situations where E-flip is not desired, set the Lower limit to -90°, which will disable this function.

Move speed - sets the speed of the camera's Pan/Tilt movements. The default setting is maximum speed.

Enable proportional speed - when using a joystick (or emulating one with the mouse), this setting can be used 
to reduce the maximum pan/tilt movement speed, i.e. the speed the camera moves at when the joystick is pushed 
all the way out in any pan/tilt direction. This is useful when the camera is zoomed in on an object and a pan/tilt 
movement is performed
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Auto-flip - the AXIS 215 PTZ will simulate continuous pan movement in the same direction, i.e. the camera will 
pan the full 360 degrees, even though there is a mechanical stop at ±170 degrees.  
This is achieved by reversing the camera lens and flipping it over when the camera reaches the mechanical stop. 
There will be a slight delay during the lens reversal. 

Movement prediction after Auto-flip - the camera will attempt to predict the new position in the pan 
movement, after compensating for the slight delay while the camera changes direction after an Auto-flip. This is 
useful for e.g. tracking moving objects or persons when using the joystick or emulated joystick mode.

See the online help for more information.

Advanced - Ctrl Panel
This allows you to add a shortcut command button to the control panel. This requires you to provide the URL 
(path) to an auxiliary command provided by the PTZ driver, or to some other command accessed via the AXIS 
VAPIX API. See the online help for more information.

Advanced - Calibration
The Area zoom functionality on the Live View page provides the possibility to zoom in on an area marked by 
drawing a square directly in the image. In order to fine-tune the precision of the square, Area zoom should first 
be calibrated from this page.

Follow the on-screen instructions to calibrate the precision of the zoom. 

Control Queue
PTZ Control Queue - the administrator can set up a queue for the PTZ controls. Once set up, the PTZ Control 
Queue buttons will appear on the Live View page offering one viewer exclusive control for a limited amount of 
time. Other users will be placed in the queue.

PTZ Control Queue on Live View page

Please see the online help for more information.
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Event Configuration
This section describes how to configure the AXIS 215 PTZ for alarm and event handling. The AXIS 215 PTZ can 
be configured to perform certain actions when certain types of events occur.

A set of parameters describing how and when the AXIS 215 PTZ is to perform certain actions

the circumstances that start an event e.g. at a signal from an external device, such as a door switch or a sensor

the circumstances that start an event e.g. at a pre-programmed time

what occurs when the event triggers e.g. uploaded video images to an FTP server, email notification, etc.

Event Servers

Event Servers are used, e.g. for receiving uploaded image files and/or notification messages. To set up Event 
server connections in your AXIS 215 PTZ, go to Setup > Event Configuration > Event Servers and enter the 
required information according to the selected server type.

For details on each setting, please refer to the online help files  which are available from each web page.

Note: Pre-trigger and Post-trigger buffers will be lost if the connection to the event server fails.

When the setup is complete, the connection can be tested by clicking the Test button (the connection test will 
take approximately 10 seconds). 

Event Type

Triggered Event page 24

Scheduled Event page 25

Action

Server type Purpose Required information

FTP Server • used for uploading saved images • Descriptive name of your choice
• Network address (host name or IP address)
• Upload path e.g. images/
• Port number
• User name/Password
• Use passive mode if there is a firewall between the PTZ camera and the FTP server
• Use temporary file if your FTP server doesn’t allow an existing file to be overwritten by a 

new file with the same name

HTTP Server • used for notification messages
• used for uploading saved images

• Descriptive name of your choice
• URL
• User Name and Password (to HTTP server)
• Proxy address/Proxy port (if required)
• Proxy User Name and Password (if required)

TCP Server • used for notification messages • Descriptive name of your choice
• Network address (host name or IP address)
• Port
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Event Types
An Event Type is a set of parameters describing how and when the AXIS 215 PTZ is to perform certain actions.

Example: If somebody passes a connected sensor and an event type has been configured to act on this, the camera can e.g. record and save 
images to an FTP server, and/or send a notification email to a pre-configured email address with a pre-configured message. Images can be sent 
as email attachments.

Triggered Event
A Triggered event is activated from, e.g:

• a switch connected to an input port on the AXIS 215 PTZ
• a manually activated action e.g. from an action button in the web interface
• on restart (reboot) after e.g. power loss

How to set up a triggered event
This example describes how to set the AXIS 215 PTZ to upload images when the main door is opened:

1. Click Add triggered on the Event types page.

2. Enter a descriptive name for the event, e.g. Main door.

3. Set the Priority - High, Normal or Low (see online help files).

4. Set the Respond to Trigger... parameters when the event is to be active, e.g. only after office hours

5. Select the trigger alternative from the Triggered by... drop-down list, e.g. an Input port with a connected 
sensor if the door is opened.

6. Set the When Triggered... parameters i.e. set what the AXIS 215 PTZ is to do if the main door is opened 
e.g. upload images to an FTP server or send an e-mail.

7. Click OK to save the Event in the Event Types list.

Please use the online help for descriptions of each available option. Image file names can be formatted 
according to specific requirements, such as time/date or type of triggered event. See File Naming & Date/Time 
Formats under Event Configuration.

Please use the online help files for descriptions of each available option.

Pre-trigger and Post-trigger buffers
This function is very useful when checking to see what happened immediately before and after a trigger, e.g. 2 
minutes before and after a door has been opened. Check the Upload images checkbox under Event Types > Add 
Triggered... > When Triggered... to expand the web page with the available options.

Note: Buffer size - up to 9 MB buffer. The maximum length of time of the pre-/post-buffer depends on the 
image size and selected frame rate.
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Include pre-trigger buffer - images stored internally in the server from the time immediately preceding the 
trigger. Check the box to enable the pre-trigger buffer, enter the desired length of time and specify the required 
image frequency.

Include post-trigger buffer - contains images from the time immediately after the trigger. Configure as for 
pre-trigger.

Note: If the pre- or post-buffer is too large for the internal memory, the frame rate will be reduced and individual images may be missing. If this 
occurs, an entry will be created in the unit's log file.

Continue image upload (unbuffered) - enable the upload of images for a fixed length of time. Specify the 
length of time for the uploaded recording, in seconds, minutes or hours, or for as long as the trigger is active. 
Finally, set the desired image frequency to the maximum (the maximum available) or to a specified frame rate. 
The frame rate will be the best possible, but might not be as high as specified, especially if uploading via a slow 
connection.

Scheduled Event
A Scheduled event can be activated at pre-set times, in a repeating pattern on selected weekdays.

How to set up a scheduled event
This example describes how to set the AXIS 215 PTZ to send an email notification with saved images from a set 
time:

1. Click Add scheduled on the Event types page.

2. Enter a descriptive name for the event, e.g. Scheduled email.

3. Set the Priority (High, Normal or Low).

4. Set the Activation Time parameters (24h clock) when the event is to be active, e.g. start on Fridays at 
18.00 with a duration of 62 hours.

5. Set the When Activated... parameters i.e. set what the AXIS 215 PTZ is to do at the specified time e.g. 
send uploaded images to an email address.

6. Click OK to save the Event in the Event Types list.

Please use the online help files for descriptions of each available option.

Motion Detection

In the Motion Detection menu, you can configure the AXIS 215 PTZ for motion detection. The motion detection 
feature is used to generate an alarm whenever movement occurs (or stops) in the image. The AXIS 215 PTZ can 
use a maximum of 10 Include/Exclude windows.

• Include windows target specific areas within the image
• Exclude windows are areas to be ignored within the Include window

Once configured, the motion detection windows will appear in a list when motion detection is selected to trigger 
an event. See How to set up a triggered event above.

Note: Using the motion detection feature may decrease overall performance in the camera.

Motion detection will not function while the lens is moving (i.e. pan, tilt, zoom)

How to configure Motion Detection

This example describes how to configure motion detection:

1. Click Motion Detection in the Event Configuration menu.

2. Click the Configure Included Windows radio button.

3. Click New.

4. Enter a descriptive name of your choice under Windows name.
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5. Adjust the size (drag the bottom right-hand corner) and position (click on the text at the top and drag 
to the desired position).

6. Adjust the Object size, History and Sensitivity profile sliders (see table below for details). Any detected 
motion within an active window is then indicated by red peaks in the Activity window (the active 
window has a red frame).

7. Click Save.

Please use the online help for descriptions of each available option.

High Only very large objects trigger 
motion detection

An object that appears in the region will trigger 
the motion detection for a long period

Ordinary colored objects against ordinary back-
grounds will trigger the motion detection

Low Even very small objects trigger 
motion detection

An object that appears in the region will trigger 
motion detection for only a very short period

Only very bright objects against a dark back-
ground will trigger motion detection

Default val-
ues

Low Medium to High Medium to High

Examples: 
• Avoid triggering on small objects in the image by selecting a high size level.
• To trigger motion detection as long as there is activity in the area, select a high history level.
• To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is recommended.

Port Status

Under Event Configuration > Port Status there is a list that shows the status for the connected inputs and 
outputs of the AXIS 215 PTZ for the benefit of the Operator who cannot access the System Options section.

Example: If the Normal state for a push button connected to an input is set to Inactive - as long as the button is not pushed, the state is 
inactive. If the button is pushed, the state of the input changes to active.

If there are parts of the Include window that you wish to exclude, click the 
Configure Excluded Windows radio button and repeat steps 1-7 above.

Parameter  Size History Sensitivity
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System Options

Security

User access control is enabled by default, the administrator sets the root password on first access. Other users are 
authorized with user names and passwords, or the administrator can choose to allow anonymous viewer login to 
the Live View page, as described below:

Users - the user list displays the authorized users and access levels:

• Viewer - the lowest level of access, which only allows the user access to the Live View page.
• Operator - an Operator can view the Live View page, create and modify event types and adjust certain 

other settings. The Operator does not have access to the Systems Options configuration pages.
• Administrator - an administrator has unrestricted access to the Setup Tools and can determine the regis-

tration of all other users.
User Settings - check the corresponding checkboxes to enable:

• Anonymous viewer login - allows any viewer direct access to the Live View page.
• Maximum number of simultaneous viewers - enter a value here to restrict the number of unicast viewers 

accessing the unit. This is useful if you need to save on bandwidth. (Note that all multicast viewers count 
as 1 viewer.)

• Anonymous PTZ control login - allows any viewer access to the Pan/Tilt/Zoom controls on the Live View 
page.

IP Address Filter

Enable IP Address Filtering - to allow or deny access to the AXIS 215 PTZ, check the box Enable IP address 
filtering. Once enabled, the IP addresses in the list will be allowed or denied access according to the choice 
made in the drop-down list Allow/Deny the following IP addresses.

The administrator can add up to 256 IP address ranges or single IP addresses to the Filtered IP Addresses list. If 
IP address filtering is enabled, the AXIS 215 PTZ will allow or deny requests coming from the IP addresses in 
the list.

See the IP address filtering help files for information on how to add IP address ranges.

The users from these IP addresses need to be specified in the user list with the appropriate access rights (User, 
Operator or Administrator).

Referrals - to prevent unauthorized sources from including the video stream from the AXIS 215 PTZ into 
external Web pages, check the Referrals checkbox and enter the IP address or Host name of the computer that 
hosts the Web pages with the included video stream. Several IP addresses/host names can be defined and are 
separated by semicolons(;)

HTTPS

For greater security, the AXIS 215 PTZ can be configured to use HTTPS (Hypertext Transfer Protocol over SSL 
(Secure Socket Layer)). That is, all communication that would otherwise go via HTTP will instead go via an 
encrypted HTTPS connection.

Certificate - to use HTTPS for communication with the AXIS 215 PTZ, a Certificate must be created using one 
of the following methods:

• A self-signed certificate can be created in the network camera, but this does not guarantee the same level of 
security as an official certificate.

• An official certificate issued by a CA (Certificate Authority). A CA issues and manages security credentials 
and public keys for message encryption.
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1. Click either Create self-signed certificate or Create Certificate Request and enter the required 
information in the provided fields.

2. Click OK.

3. Create self-signed certificate generates and installs a certificate which will be displayed under Installed 
Certificate. 
Create Certificate Request generates a PEM formatted request which you copy and send to a CA for 
signing. When the signed certificate is returned, click Install signed certificate... to install the certificate 
in the AXIS 215 PTZ.

4. Set the HTTPS Connection Policy for the administrator, Operator and Viewer to enable HTTPS connection 
(set to HTTP by default)

Please refer to the home page of your preferred CA for information on where to send the request etc. For more 
information, please refer to the online help files

802.1X - Network Admission Control

IEEE 802.1X is an IEEE standard for port-based Network Admission Control. It provides authentication to 
devices attached to a network port (wired or wireless), establishing a point-to-point connection, or, if 
authentication fails, preventing access on that port. 802.1X is based on EAP (Extensible Authentication 
Protocol). 

In an 802.1X enabled network switch, clients equipped with the correct software can be authenticated and 
allowed or denied network access at the Ethernet level. 

Clients and servers in an 802.1X network may need to authenticate each other by some means. In the Axis 
implementation this is done with the help of digital certificates provided by a Certification Authority. These are 
then validated by a third-party entity, such as a RADIUS server, examples of which are Free Radius and 
Microsoft Internet Authentication Service.

To perform the authentication, the RADIUS server uses various EAP methods/protocols, of which there are 
many. The one used in the Axis implementation is EAP-TLS (EAP-Transport Layer Security). 

The AXIS network video device presents its certificate to the network switch, which in turn forwards this to the 
RADIUS server. The RADIUS server validates or rejects the certificate and responds to the switch, and sends its 
own certificate to the client for validation. The switch then allows or denies network access accordingly, on a 
pre-configured port. 

The authentication process

1. A CA server provides the required signed certificates.

2. The Axis video device requests access to the protected network at the network switch. The switch 
forwards the video device’s CA certificate to the RADIUS server, which then replies to the switch.

3. The switch forwards the RADIUS server’s CA certificate to the video device, which also replies to the 
switch. 

4. The switch keeps track of all responses to the validation requests. If all certificates are validated, the 
Axis video device is allowed access to the protected network via a pre-configured port.

RADIUS (Remote Authentication Dial In User Service) - AAA (Authentication, Authorization and Accounting) 
protocol for applications such as network access or IP mobility. It is intended to work in both local and roaming 
situations.

CA servers - In cryptography, a Certification Authority (CA) is an entity that provides signed digital certificates 
for use by other parties, thus acting a trusted third party. There are many commercial CA’s that charge for their 
services. Institutions and governments may have their own CA, and there are free CA’s available.
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Date & Time

Current Server Time - displays the current date and time (24h clock). If this has not been configured, the time 
displayed is the default setting. The time can be displayed in 12h clock format in the Overlay Images (see below).

New Server Time - Select your time zone from the drop-down list and check the daylight saving time changes, 
if desired. 

From the Time Mode section, select the preferred method to use for setting the time:

• Synchronize with computer time - sets the time from the clock on your computer. 
• Synchronize with NTP Server - the AXIS 215 PTZ will obtain the time from an NTP server every 60 minutes. 

Specify the NTP server's IP address or host name.  
Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. See 
Network > TCP/IP below.

• Set manually - this option allows you to manually set the time and date.
Date & Time Format Used in Images - specify the formats for the date and time (12h or 24h) displayed in the 
Live View video streams.

Use the predefined formats or use your own custom date and time formats. See Advanced File Naming & 
Date/Time Formats in the help files for information on how to create your own file formats.

Network 

Basic TCP/IP Settings

The AXIS 215 PTZ supports both IP version 4 and IP version 6. Both versions may be enabled simultaneously, 
and at least one version must always be enabled. 

IPv4 Address Configuration - when using IPv4, the IP address for the AXIS 215 PTZ can be set automatically 
via DHCP, or a static IP address can be set manually.

IPv6 Address Configuration - If IPv6 is enabled, the AXIS 215 PTZ will receive an IP address according to the 
configuration in the network router.

There are also options for setting up notification of changes in the IP address, and for using the AXIS Internet 
Dynamic DNS Service. For more information on setting the IP address, please see the online help.

Notes: • DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via DHCP may lead to the situation 
where the IP address changes and you lose contact. Configure the options for notification of IP address change (under Services) to 
receive notification from the network camera when the IP address changes.

• Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 215 PTZ by host name which is always the same, 
regardless of the IP address.

For more information, please refer to the online help files

Services

Enable ARP/Ping setting of IP address - The IP address can be set using the ARP/Ping method, which associates 
the unit's MAC address with an IP address. Check this box to enable the service. Leave disabled to prevent 
unintentional resetting of the IP address.

Notes: • The ARP/Ping service is automatically disabled 2 minutes after the unit is started, or as soon as an IP address is set.
• Pinging the unit will still be possible when this service is disabled. 

 
Options for notification of IP address change - if the IP Address for the AXIS 215 PTZ is changed 
automatically, e.g. by DHCP, you can choose to be notified. Click Settings... and enter the required information.

AXIS Internet Dynamic DNS Service - If the AXIS 215 PTZ has been registered with the Axis Internet Dynamic 
DNS service and the IP address for the product changes, the service is updated to reflect the change. Check the 
box to enable/disable automatic updates.
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The domain name currently registered at the Axis Internet Dynamic DNS service for your product can at any 
time be removed. To do this click Settings... and follow the instructions. 

For more information, please refer to the online help files

Advanced TCP/IP Settings

DNS Configuration - DNS (Domain Name Service) provides the translation of host names to IP addresses on 
your network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided by the DHCP server. 
Click the View button to see the current settings.

Use the following DNS server address - enter the desired DNS server by specifying the following:

• Domain name - enter the domain(s) to search for the host name used by the AXIS 215 PTZ. Multiple domains can 
be separated by semicolons (;). The host name is always the first part of a Fully Qualified Domain Name, e.g. 
myserver is the host name in the Fully Qualified Domain Name myserver.mycompany.com where 
mycompany.com is the Domain name.

• Primary DNS server - enter the IP address of the primary DNS server.
• Secondary DNS server - will be used if the primary DNS server is unavailable.

NTP Configuration - The AXIS 215 PTZ can obtain the correct time from an NTP server. The address for the NTP 
server can either be obtained via the DHCP server, or it can be entered manually. 

Host Name Configuration - The AXIS 215 PTZ can be accessed using a host name, instead of an IP address. The 
host name is usually the same as the assigned DNS Name. It is always the first part of a Fully Qualified Domain 
Name and is always one word, with no period. For example, myserver is the host name in the Fully Qualified 
Domain Name myserver.mycompany.com.

The enable dynamic DNS updates allows you to alias a dynamic IP address to a static host name, allowing your 
computer to be more easily accessed from various locations on the Internet. Outside users can always access 
your server using the associated DNS name regardless of the WAN IP. The DNS server used by the user and/or 
the DNS server responsible for the domain in use must support RFC2136 and allow updates from the camera.

The TTL (Time To Live) value determines how long (in seconds) the reply from the DNS server should be 
remembered when checking that the domain name for the registered IP address is still valid.

Link-Local IPv4 Address

This is enabled by default and assigns the AXIS 215 PTZ an additional IP address for use with UPnP™. The AXIS 
215 PTZ can have both a Link-Local IP and a static/DHCP-supplied IP address at the same time - these will not 
affect each other.

HTTP - The default HTTP port number (port 80) can be changed to any port within the range 1024-65535. This 
is useful for e.g. simple security port mapping.

HTTPS - If applicable, enter the HTTPS port the AXIS 215 PTZ will use. The default setting (443) can be changed 
to any port within the range 1024-65535. HTTPS is used to provide encrypted web browsing.

NAT Traversal (port mapping) for IPv4 - Use NAT traversal when your AXIS 215 PTZ is located on an intranet 
(LAN) and you wish to make it available from the other (WAN) side of a NAT router. With NAT traversal 
properly configured, all HTTP traffic to an external HTTP port in the NAT router will be forwarded to the 
network camera. 

Enable/Disable - When enabled, the AXIS 215 PTZ will attempt to configure port mapping in a NAT router on 
your network, using UPnP™. 

Use manually selected NAT router - Select this option to manually select a NAT router. Enter the IP address for 
the router in the field provided.  
If a router is not manually specified, the AXIS 215 PTZ Network Camera will automatically search for NAT 
routers on your network. If more than one router is found, the default router will be selected.
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Alternative HTTP port - Select this option to manually define an external HTTP port. Enter the port number in 
the field provided. If no port is entered here a port number will automatically be selected when NAT traversal is 
enabled. 

FTP - The FTP server running in the AXIS 215 PTZ enables the upload of e.g. new firmware, user applications, 
etc. Check the box to enable the service.

RTSP - The RTSP protocol allows a connecting client to start an MPEG-4 stream. Enter the RTSP port number to 
use. The default setting is 554.

Network Traffic 

The default setting is Auto-negotiate which means that the correct speed is automatically selected. If necessary, 
you can set the connection speed by selecting it from the drop-down list. 10BaseT (Half/Full Duplex), 
100BaseTX (Half/Full Duplex).

Maximum bandwidth - Specify, in Mbit/s or Kbit/s, the maximum bandwidth that the AXIS 215 PTZ is allowed 
to use on your network. This is a useful function when connecting the AXIS 215 PTZ to busy or heavily loaded 
networks. The default setting is Unlimited.

For more information, please refer to the online help files

Network - SOCKS 

SOCKS is a networking proxy protocol. The AXIS 215 PTZ can be configured to use a SOCKS server to reach 
networks on the other side of a firewall/proxy server. This functionality is useful if the AXIS 215 PTZ is located 
on a local network behind a firewall, but notifications, uploads, alarms, etc., need to be sent to a destination 
outside the local network (e.g. to the Internet).

Network - QoS (Quality of Service)

Quality of Service (QoS) provides the means to guarantee a certain level of a specified resource to selected traffic 
on a network. Quality can be defined as e.g. a maintained level of bandwidth, low latency, no packet losses, etc. 
The main benefits of a QoS-aware network can be summarized as:

• The ability to prioritize traffic and thus allow critical flows to be served before flows with lesser priority.
• Greater reliability in the network, thanks to the control of the amount of bandwidth an application may 

use, and thus control over bandwidth races between applications.
The QoS in Axis network video products marks the data packets for various types of network traffic originating 
from the product. This makes it possible for network routers and switches to e.g. reserve a fixed amount of 
bandwidth for these types of traffic. The types of traffic marked by the camera are video, audio, event/alarm and 
management network traffic.

QoS DSCP Settings

For each type of network traffic supported by your Axis network video product, enter a DSCP (Differentiated 
Services Codepoint) value. This value is used to mark the traffic’s IP header. When the marked traffic reaches a 
network router or switch, the DSCP value in the IP header tells the router or switch which type of treatment to 
apply to this type of traffic, for example, how much bandwidth to reserve for it.

Note that DSCP values can be entered in decimal or hex form, but saved values are always shown in decimal. 
For more information on Quality of Service, please see the Axis support web at www.axis.com/techsup

Network - SMTP (email)

Simple Mail Transfer Protocol (SMTP) - enter the host names or addresses for your primary and secondary mail 
servers in the fields provided to enable event and error email messages from the AXIS 215 PTZ to predefined 
addresses, via SMTP.
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Network - SNMP
The Simple Network Management Protocol (SNMP) allows remote management of network devices. Depending 
on the level of security required, select the version of SNMP to use. The three levels of security are:

• SNMP V1 - includes no security.
• SNMP V2c - uses very simple security. The community name can be specified as a password for read or 

read/write access to all supported SNMP objects. The community is the group of network devices using 
SNMP.

• SNMP V3 - provides encryption and secure passwords. HTTPS must be enabled.

Network - UPnP

The AXIS 215 PTZ includes support for UPnP in Windows Millennium and Windows XP. UPnP is enabled by 
default.

Note: UPnP must be installed on your workstation. To do this, open the Control Panel from the Start Menu and select Add/Remove Programs. 
Select Add/Remove Windows Components and open the Networking Services section. Click Details and then select UPnP as the ser-
vice to add.

Network - RTP/MPEG-4

Multicast must be enabled for these settings to take effect. The settings are only valid when MPEG-4 is used as 
the video format. These settings are the port range, IP address, port number, and Time-To-Live value to use for 
the video stream(s) in MPEG-4 format. Only certain IP addresses and port numbers should be used for multicast 
streams.

Enter the port range, IP address and the port number to use for the video and audio streams in the required 
fields.

Only IP addresses within certain ranges can be used for multicasting. The camera has been pre-configured with 
an address from these ranges, and this does not normally need to be changed. Please contact your network 
administrator if you have special requirements.

Notes: • Viewers do not need to know this IP address or port number, but simply the main IP address or host name otherwise used for accessing 
the camera.

• Setting the video port number to 0 means a random port number will be used.

If IP packets (i.e. data) fail to be delivered to their destination within a reasonable length of time the number 
entered in the Time to live field tells the network routers when to discard the packet. The value is usually 
measured in ‘hops’, i.e. the number of network routers that can be passed before the packet arrives at its 
destination or is dropped.

Network - Bonjour

The AXIS 215 PTZ includes support for Bonjour. When enabled, the camera is automatically detected by 
operating systems and clients that support this.

Ports & Devices - I/O Ports

Ports can be given descriptive names and their Normal state can be configured.

The 2 options for Normal state are Open circuit and Grounded circuit. The input is activated when the Current 
state changes so that it no longer equals the Normal state.

As an example, if the Normal state for a pushbutton connected to an input is Open circuit, this means that as 
long as the button is not pushed (and the Current state remains as Open Circuit), the state will be inactive.
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For more information, please refer to the online help files

Maintenance

• Restart - the unit is restarted without changing any of the settings. Use this method if the unit is not behav-
ing as expected.

• Restore - the unit is restarted and most current settings are reset to factory default values. The settings that 
will not be reset are as follows:
• boot protocol (DHCP or static)
• static IP address
• default router
• subnet mask
• system time

• Default - the Factory default button should be used with caution. Pressing this button will reset all of the 
AXIS 215 PTZ's settings to the factory default values (including the IP address). 
 

PTZ Status - click the Test button to check the pan, tilt, zoom mechanics and camera for errors. If you receive 
an error message as the result of this test, contact Axis Customer Services at www.axis.com/techsup

Upgrade Server - See Updating the Firmware, on page 37.

Backup - click the Backup button to take a backup of all of the parameters, and any user-defined scripts. If 
necessary, it is then possible to return to the previous settings if the settings are changed and there is 
unexpected behavior.

Note: The root password will also be reset to the password saved in the backup file.

Restore - click the Browse button to locate the saved backup file (see above) and then click the Restore button. 
The settings will be restored to the previous configuration.

Note: Backup and Restore can only be used on the same unit running the same firmware. This feature is not intended for multi-configura-
tions or for firmware upgrades.
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Support
The support overview page provides valuable information on troubleshooting and contact information, should 
you require technical assistance.

Support - System Overview is a quick look over the camera’s status and settings. Information that can be 
found here includes the camera’s Firmware version, IP address, Security, Event and Image settings and Recent 
log items. Many of the captions are also links to the proper Setup page to conveniently make adjustments in the 
camera’s settings. 

Support - Logs & Reports - when contacting Axis support, please be sure to provide relevant information with 
your query:

Logs - the Log report including all log information

Reports - the Server Report and Parameter List provide valuable information for troubleshooting, be sure to 
include the server report when contacting Axis’ support service.

Configuration

• Log Level for Log Files - from the drop-down list, select the level of information to be added to the Log file
• Log Level for Email - from the drop-down list, select the level of information to send as email and enter the 

destination email address.

Advanced

Scripting is an advanced function that provides the possibility to customize and use scripts. This function is a 
very powerful tool. 

Caution!
Improper use may cause unexpected behavior or even cause loss of contact with the unit. If a script does cause 
problems, reset the unit to its factory default settings. A backup file may be of use to return the unit to its latest 
configuration. 
 
Axis strongly recommends that you do not use this function unless you fully understand the consequences. 
Note that Axis support does not provide assistance for problems with customized scripts. 

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with experience of Axis network camera configuration. All 
parameters can be set and modified from this page. Help is available from the standard help pages.

Resetting to Factory Default Settings

To reset the AXIS 215 PTZ to the original default settings, go to the System Options > Maintenance web page 
(described in Maintenance, on page 33) or use the Reset button on the AXIS 215 PTZ as described below:

Using the Reset Button

Follow the instructions below to reset the AXIS 215 PTZ to factory default settings using the Reset Button.

1. Switch off the AXIS 215 PTZ by disconnecting the power supply.

2. Press and hold the Reset button while you reconnect the power connector.

3. Keep the Reset button pressed for approximately 15 seconds.

4. Release the Reset button.

Note: Resetting to the factory default settings using the Reset Button will cause all parameters (including the IP address) to be reset. Refer to 
Maintenance, on page 33 for other methods that do not reset the IP address.
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Unit Connectors
This section describes the following:

• The I/O terminal block
• LED indicators
• Power connection

I/O terminal 
connector

Audio in
Audio out Indicator LEDs

Status/network/power
Network connector

Control button

Power connector

I/O terminal connector

Used in applications for e.g. motion detection, event triggering,

Pin 4
Pin 3

Pin 2
Pin 1

 time lapse recording 
and alarm notifications. It provides the interface to: 

• 1 transistor output - For connecting external devices such as relays and 
LEDs. Connected devices can be activated by AXIS VAPIX API, output but-
tons on the Live View page or by an Event Type. The output will show as 
active (shown under Event Configuration > Port Status) if the alarm 
device is activated.

• 1 digital input - An alarm input for connecting devices that can toggle between an open and closed 
circuit, for example: PIRs, door/window contacts, glass break detectors, etc. When a signal is received 
the state changes and the input becomes active (shown under Event Configuration > Port Status).

• Auxiliary power and GND

GND 1

12V DC 
Power

2 Can be used to power auxiliary equipment. Note that the AXIS 215 PTZ itself 
cannot be powered via the I/O terminal connector.

Max load = 100mA

Digital 
Input

3 Connect to GND to activate, or leave floating (or unconnected) to deactivate. Must not be exposed to voltages 
greater than 12V DC

Transistor 
Output

4 Uses an open-collector NPN transistor with the emitter connected to the 
GND pin. If used with an external relay, a diode must be connected in paral-
lel with the load, for protection against voltage transients.

Max load = 100mA 
Max voltage = 24V DC  
(to the transistor)

Network connector - RJ-45 Ethernet connector. Using shielded cables is recommended.

Power connector - Mini DC connector 12V DC ±5%, max 11.5W. See product label for ± connection.

Function Pin number Notes Specifications
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Audio in - 3.5mm input for a mono microphone, or a line-in mono signal (left channel is used from a stereo 
signal).

Audio out - Audio output (line level) that can be connected to a public address (PA) system or an active speaker 
with a built-in amplifier. A pair of headphones can also be attached. A stereo connector must be used for the 
audio out.

Connection diagram

o

AXIS 215 PTZ

12V 
max. 100mA

e.g. pushbutton

4

o3

o

o

2

1

LED indicators

Network Green Steady for connection to a 100 Mbit/s network. Flashes for network activity.

Amber Steady for connection to 10 Mbit/s network. Flashes for network activity.

Unlit No network connection.

Status Green Steady green for normal operation.

Amber Steady during startup, during reset to factory default or when restoring settings.

Red Slow flash for failed upgrade.

Power Green Normal operation.

Amber Flashes green/amber during firmware upgrade.

 

Power connection
Connect the supplied indoor power adapter to the power connector in the camera casing.

LED Color Indication
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Troubleshooting

Checking the Firmware

The firmware is software that determines the functionality of the AXIS 215 PTZ. When you download firmware 
from the Axis Website, your Axis product will receive the latest available functionality.

One of your first actions when troubleshooting a problem should be to check the currently installed firmware 
version. The latest version may contain a correction that fixes your particular problem. The current software 
version in your AXIS 215 PTZ is available under Setup > Basic Configuration.

Updating the Firmware

New firmware can be downloaded to the AXIS 215 PTZ over the network. Always read the upgrade instructions 
available with each new release, before updating the firmware.

1. Save the firmware file to your computer. The latest version of the AXIS 215 PTZ firmware is available free 
of charge from the Axis Website at http://www.axis.com/techsup or from your local distributor.

2. Go to Setup > System Options > Maintenance in the AXIS 215 PTZ Web pages.

3. In the Upgrade Server section and browse to the firmware file on your computer. Click Upgrade.

4. Wait at least 20 minutes before restarting the AXIS 215 PTZ after upgrading.

Notes: • Pre-configured and customized settings will be retained for use when the new firmware is running (providing that the features are 
available in the new firmware) although this is not guaranteed by Axis Communications.

• After starting the process, you should always wait at least 20 minutes before restarting the AXIS 215 PTZ, even if you suspect the 
procedure has failed.

• Your dealer reserves the right to charge for any repair attributable to faulty updating by the user.
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Customer Services
If you contact the Axis support desk, please help us help you resolve your problems expediently by providing a 
server report, log file and a brief description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report contains important 
information about the server and its software, as well as a list of the current parameters.

Log file - go to Setup > System Options > Logs & Reports. The Log file records events within the unit since the 
last restart of the system and can prove a useful diagnostic tool for troubleshooting.
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Symptoms, Possible Causes and Remedial Actions  
Problems setting the IP address

Using ARP Ping The IP address must be set within two minutes after the power has been applied to the AXIS 215 PTZ, restart the server 
and try again. Also, make sure the ping length is set to 408. 

The AXIS 215 PTZ is located on a differ-
ent subnet

If the IP address intended for the AXIS 215 PTZ and the IP address of your computer are located on different subnets, 
you will not be able to set the IP address. Contact your network administrator for an IP address on the same subnet as 
the computer you are performing the installation from.

The IP address is being used by another 
device

Disconnect power from the AXIS 215 PTZ.  
Run the Ping command (in a Command/DOS window, type ping and the IP address of the unit). 

If you receive: Reply from <IP address>: bytes = 32; time = 10 ms..... - this means that the IP address may already 
be in use by another device on your network. You must obtain a new IP address and reinstall the unit. 

If you receive: Request timed out - this means that the IP address is available for use with your AXIS 215 PTZ. In this 
case, check all cabling and reinstall the unit.

The AXIS 215 PTZ cannot be accessed from a browser
The IP address has been changed by 
DHCP

1) Move the AXIS 215 PTZ to an isolated network or to one with no DHCP or BOOTP server. Set the IP address again, 
using the ARP Ping command. 
2) Access the unit and disable BOOTP and DHCP in the TCP/IP settings. Return the unit to the main network. The unit 
now has a fixed IP address that will not change. 
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the required service and then 
configure IP address change notification from the network settings. Return the unit to the main network. The unit will 
now have a dynamic IP address, but will notify you if the address changes.

Other networking problems Test the network cable by connecting it to another network device, then Ping that device from your workstation. 

Cannot send notifications, uploads, alarms, etc, to a destination outside the local network.
Firewall protection The AXIS 215 PTZ can be configured to use a SOCKS server to reach networks on the other side of a firewall/proxy 

server.

Your AXIS 215 PTZ is accessible locally, but not externally
Firewall protection Check the Internet firewall with your system administrator.

Default routers required Check if you need to configure the default router settings.

The Internet site is too heavily loaded Use a script running on your web server to relay images from the AXIS 215 PTZ to the Internet.

A firmware upgrade has been interrupted 
or the firmware has in some other way 
been damaged

A rescue firmware is running in the product. First, set the IP address using AXIS IP utility or ARP and Ping,

Then, from a Web browser, access the unit and download the latest firmware to the product, see Updating the Firm-
ware, on page 37.

Problems with the MPEG-4 format
No MPEG-4 displayed in the  
client.

Check that the correct network interface is selected in the AMC control panel applet (network tab). 

Check that the relevant MPEG-4 connection methods are enabled in the AMC control panel applet (network tab). 

In the AMC control applet, select the MPEG-4 tab and click the button Set to default MPEG-4 decoder. 

No multicast MPEG-4 displayed in the 
client.

Check with your network administrator that the multicast addresses used by the  
AXIS 215 PTZ are valid for your network.

Check with your network administrator to see if there is a firewall preventing viewing.

Multicast MPEG-4 only accessible by 
local clients. 

Check if your router supports multicasting, or if the router settings between the client and the server need to be con-
figured. The TTL (Time To Live) value may need to be increased.

Poor rendering of MPEG-4 images Color depth set incorrectly on clients. Set to 16-bit or 32-bit color.

If text overlays are blurred, or if there are other rendering problems, you may need to enable Advanced Video Render-
ing from the MPEG-4 tab in the AMC control panel applet.

Ensure that your graphics card is using the latest device driver. The latest drivers can usually be downloaded from the 
manufacturer's website. 

Color saturation is different in MPEG-4 
and Motion JPEG.

Modify the settings for your graphics adapter. Please see the adapter's documentation for more information.

Lower frame rate than expected. Reduce number of applications running on the client computer.

Check with the system administrator that there is enough bandwidth available. See also the online help.

Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to Decode only I frames.
Lower the image resolution.

Image degeneration. Decrease the GOV length, see the online help for more information.

No images displayed in the Web interface
Problem with AMC  
(Internet Explorer for Windows only)

To enable the updating of images in Microsoft Internet Explorer for Windows, set your Web browser to allow ActiveX 
controls. Also, make sure that AXIS Media Control (AMC) component is installed on your workstation. 

Installation of additional ActiveX compo-
nent restricted or prohibited

Configure your AXIS 215 PTZ to use a Java applet for updating the images under 
Live View Config > Layout > Default Viewer for Internet Explorer. See help files for more information.

 

 

 39 



AXIS 215 PTZ - Troubleshooting 
For additional assistance, please contact your reseller or check the product’s support pages on the Axis 
Website at http://www.axis.com/techsup

Video Image Problems
Distorted colors Problems may occur if the image contains no white color at all, or if the dominant color is not white. In these circum-

stances, the white balance may incorrectly be based on another visible color in the image, and colors may become dis-
torted. A pale background picture with reddish or blue foreground objects is very symptomatic of this condition. In 
such cases it is recommended that a fixed white balance setting is selected.

Image too dark or too light See the help on Video & Image Settings.

Problems uploading own files There is only limited space available for the upload of your own files. Try deleting one or more existing files, to free up 
space.

Missing images in uploads This can occur when trying to use a larger image buffer than is actually available. Try lowering the frame rate or the 
upload period.

Slow image update Configuring, e.g. pre-buffers, hi-res images, high frame rate etc will reduce the performance of the AXIS 215 PTZ. 

Slow performance Slow performance may be caused by e.g. heavy network traffic, many users with access to unit, low performing client, 
use of features such as Event handling., Image rotation.

Bad snapshot images
Display incorrectly configured on your 
workstation

In Display Properties, configure your display to show at least 65000 colors, i.e. at least 16-bit.

Using only 16 or 256 colors on your display will produce dithering artifacts in the image. 

Audio problems
No audio Check that: 

• PC sound card, speakers and microphone are correctly connected

• the Mute button is not pressed

• the volume in and volume out settings are correct

• all cabling is connected

• the value of the Post Content Length in your proxy server is 1MB or more. You may need to contact your system 
administrator to do this.

No full-duplex function Incorrect configuration. Check the setting in the camera’s Setup pages.

Sound card does not support full-duplex. For information on how to check if your sound card supports full-duplex, 
please visit www.axis.com and see the support section for Axis camera products.

Poor performance Too many users/clients connected. Try limiting the number of clients allowed to connect.

Low bandwidth. Reduce the Speed setting on the Audio settings page. Setting lower speed will reduce any break-up in 
the sound, but will also increase the transmission delay. If running in Full-Duplex mode, try switching to Half-Duplex 
mode.

Whining or screeching sound from speak-
ers (feedback)

Poor positioning of speakers and/or microphone. Relocate the speakers or microphone so that they do not point 
towards each other, and/or lower the volume.

Mechanical problems
problem with pan, tilt, zoom mechanics Click the PTZ Status - Test button under System Options > Maintenance to check the pan, tilt, zoom mechanics and 

camera for errors. If you receive an error message as the result of this test, contact Axis Customer Services at 
www.axis.com/techsup
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Technical Specifications

Item Specification

Models • AXIS 215 PTZ 60Hz
• AXIS 215 PTZ 50Hz

Image sensor 1/4” sony Interlaced CCD

Lens F1.6-F2.7
f=3.8-46mm
Automatic day/night
Autofocus
Focus range: 300 mm (wide) or 1000 mm (tele) to infinity

Angle of view 4.4° - 51.6° horizontal

Zoom 12x optical and 4x digital, total 48x

Minimum illumination Color: 1 lux at 30 IRE, F1.6
B/W: 0.3 lux at 30 IRE, F1.6

Pan Range +/-170° (360° panning via Auto-flip)

Tilt Range 180°

Max speed Pan: 180°/sec 
Tilt: 140°/sec

Video compression Motion JPEG
MPEG-4 Part 2 (ISO/IEC 14496-2), ASP level 0-5, SP level 0-3

Resolutions 4CIF, 2CIFExp, 2CIF, CIF, QCIF
Max 704x480 (NTSC) 704x576 (PAL)
Min 176x120 (NTSC) 176x144 (PAL)

Frame rate
(NTSC/PAL) 

Motion JPEG: 
Up to 30/25 fps in all resolutions
MPEG-4: 
Up to 30/25 fps at 2CIF/CIF/QCIF
Up to 25/21 fps at 4CIF/2CIFExp

Video streaming Simultaneous Motion JPEG and MPEG-4
Controllable frame rate and bandwidth
Constant and variable bitrate (MPEG-4)
3GPP and ISMA compatible

Image settings De-interlace (4CIF resolution)
Compression levels: 100
Rotation: 0°, 180°
Aspect ratio correction
Configurable white balance, exposure control, brightness, sharpness and color mode
Overlay capabilities: Zone ID, preset ID, time, date, PTZ coordinates, text or image
Automatic or manual day/night mode
Backlight compensation

Pan/tilt/zoom Auto-flip
E-flip
20 preset positions
Sequence mode
Control queue
Image freeze
Supports Windows compatible joysticks
Designed for operator control*

*Not designed for continuous PTZ movements e.g. Guard tour. For continuous movement, please see Axis network 
dome offering

Shutter time • NTSC: 4/3 - 1/50000 sec
• PAL: 8/5 - 1/50000 sec

Audio Two-way (full or half duplex) or one-way
G.711 PCM 64kbit/s, G.726 ADPCM 32 or 24 kbit/s
Requires external microphone or line in. Mono audio output (line level) connects to PA system or active speaker 
with built-in amplifier
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Security Multiple user access levels with password protection
IP address filtering
HTTPS encryption
IEEE 802.1X network access control

Users 20 simultaneous unicast users
Unlimited users using multicast (MPEG-4)

Alarm and event 
management

Events triggered by
• built-in multi-window motion detection
• external input
• audio detection
• temperature
• PTZ preset position
• according to schedule
Image upload over FTP, email and HTTP                                                                                                                                                                                                                      
Notification over TCP, email, HTTP
Pre- and post alarm buffering in Motion JPEG up to 9 MB (approx 4 min of CIF resolution video at 4 fps)

Connectors Ethernet 10BaseT/100BaseTX, RJ-45
Terminal block for 1 alarm input, 1 output and  power out for I/O
Audio line/mic in
Audio line out

Processors and memory AXIS ETRAX FS 32-bit RISC CPU
AXIS  ARTPEC-2 video compression chip
32 MB RAM, 8 MB flash
Battery backed up real-time clock

Power 12VDC ±5%, max 14.5W

Operating conditions • 0-45 °C
• Humidity 20 - 80% RH (non-condensing)

Temperature warning Warning issued when temperature is below or above limits

Installation, management 
and maintenance

Installation tool on CD and Web-based configuration
Configuration backup and restore
AXIS Camera Station One for recording. AXIS Camera Management for camera management.
Firmware upgrades over HTTP or FTP, firmware available at  www.axis.com

Video access from
Web browser

Camera live view for up to 20 clients
Video recording to file (ASF)
Sequence tour for up to 20 Axis video sources
Customizable HTML pages

Minimum web browsing 
requirements

• Pentium III CPU 500 MHz or higher, or equivalent AMD,128 MB RAM,  
AGP graphics card 32 MB RAM, Direct Draw

• Windows XP, 2000, DirectX 9.0 or later 
• Internet Explorer 6.x or later
• For other operating systems and browsers see www.axis.com/techsup

System integration support • Open API for application integration, including AXIS VAPIX API*, AXIS Media Control SDK*,  
event trigger data in video stream

• Quality of Service (QoS) Layer 3, DiffServ Model
• Watchdog ensures continuous operation, event notifications can be monitored by other systems
• Embedded Linux operating system
 
* Available at www.axis.com

Supported protocols IPv4/v6, HTTP, HTTPS, SSL/TLS*, TCP, QoS, SNMPv1/v2c/v3 (MIB-II), RTSP, RTP, UDP, IGMP, RTCP, SMTP, FTP, ICMP, 
DHCP, UPnP, Bonjour, ARP, DNS, DynDNS, SOCKS, NTP, IEEE 802.1X. More information on protocol usage 
available at www.axis.com

*This product includes software developed by the Open SSL Project for use in the Open SSL Tool kit 
(www.openssl.org)

Video management 
software (not incl.) 

AXIS Camera Station – Surveillance application for viewing, recording and archiving up to 25 cameras

See www.axis.com/partner/adp_partners.htm for more software applications via partners

Item Specification
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Accessories  
(included)

• Indoor power supply AXIS PS-P 12VDC
• Hard ceiling and drop ceiling mount kits
• Clear and smoked domes
• Installation Guide
• CD with installation tool, software and User’s Manual
• MPEG-4 licenses (1 encoder, 1 decoder)
• MPEG-4 decoder (Windows)

Accessories  
(not included)

• Outdoor housing solutions
• Outdoor power supply
• IR illuminators
• AXIS 295 Video Surveillance Joystick

Approvals - EMC •  EN55024,
•  EN55022 Class B,
•  EN61000-3-2,
•  EN61000-3-3,
•  EN60950-1,
•  FCC Part 15 Subpart B Class B,
•  ICES-003 Class B,
•  C-tick AS/NZS 3548
 
Power supply: UL, CSA, CE

Dimensions 
(HxWxD) and weight

• 128 x 153 x 131 mm (5.0” x 6.0” x 5.2”) excl. cover 
132 x 162 x 149 mm (5.2" x 6.4" x 5.9") incl. hard ceiling cover

• 730g incl. hard ceiling cover 
1260g incl. drop ceiling mounting bracket and cover

Item Specification
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File sizes
The AXIS 215 PTZ delivers the following file sizes (PAL):

PAL PAL aspect ratio corrected

The AXIS 215 PTZ delivers the following file sizes (NTSC):

General performance considerations
When setting up the camera, it is important to consider how various settings and situations will affect 
performance. Some factors affect the amount of bandwidth (the bit rate) required, others can affect the frame 
rate, and some will affect both. If the load on the CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

• High image resolutions and/or lower compression levels result in larger images. Bandwidth affected. 
• Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Bandwidth affected.
• Simultaneous viewing of different streams (resolution, compression, etc.) by many clients. Frame rate 

and bandwidth affected.
• Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame rate and bandwidth 

affected.
• Heavy usage of event settings affects the CPU load. Frame rate affected.
• Enabled motion detection. Frame rate and bandwidth affected.
• Heavy network utilization due to poor infrastructure. Bandwidth affected.
• Viewing on poorly performing client PC lowers perceived performance. Frame rate affected.
• Access by large number of audio clients using full-duplex mode. Bandwidth affected.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the AXIS 215 PTZ provides a tool 
that can be used to display these values directly in the video image.

To do this, special format strings are added as part of a text overlay. 
Simply add #r (average frame rate in fps) and/or #b (average bandwidth 
in Kbps) to the overlay. 

For detailed instructions, please see the online help for Video & Image > 
Overlay Settings, and the help for File Naming & Date/Time Formats. 

Resolution Min-Max (KB) Resolution Min-Max (KB)
4CIF 704x576 10 - 300 4CIF 768x576 11 - 330

2CIF expanded 704x576  10 - 250 2CIF expanded 768x576  11 - 270
2CIF 704x288 5 - 150 2CIF 768x288  5.5 - 160
CIF  352x288  2.5 -  80 CIF 384x288 2.7 -  90

QCIF 176x144 1 -  20 QCIF 192x144 1.1 -  22

NTSC NTSC aspect ratio corrected
Resolution Min-Max (KB) Resolution Min-Max (KB)

4CIF 704x480  8 - 250 4CIF 640x480  7 - 230
2CIF expanded 704x480 8 - 200 2CIF expanded  640x480  7 - 180

2CIF 704x240  4 - 125 2CIF  640x240 3.5 - 110
CIF 352x240 2 -  70 CIF 320x240  1.8 -  60

QCIF 176x120  0.8 -  15 QCIF  160x120 0.7 -  14
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Important!
•The figures displayed here are the values as delivered by the camera. If other restrictions are currently in force, (e.g. band-

width limitation) these values might not correspond to those actually received by the client.

•For Motion JPEG, these values will only be accurate as long as no frame rate limit has been specified.

Frame rates - Motion JPEG
The following test results show the frame rates in frames/second (fps) for Motion JPEG streams from the AXIS 
215 PTZ, using a compression level of 50%. Note that these values are guidelines only - actual values may vary.

Frame rates - MPEG-4
The following test results show the frame rates in frames/second (fps) for MPEG-4 streams from the AXIS 215 
PTZ. Note that these values are guidelines only - actual values may vary.

The MPEG-4 test conditions:

• Compression level = 50%
• Video Object Type = Advanced Simple
• GOV structure = IP*

*Note that setting the GOV structure to use “I-frames only” will increase the frame rate.

Bandwidth
As there are many factors affecting bandwidth, it is very difficult to predict the required amounts. The settings 
that affect bandwidth are:

• the image resolution
• the image compression
• the frame rate
• the MPEG-4 object type
• the MPEG-4 GOV structure
• the audio settings

There are also factors in the monitored scene that will affect the bandwidth. These are: 

• the amount of motion
• the image’s complexity
• the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important than the image quality, 
using a constant bit rate (CBR) is recommended. Use a variable bit rate (VBR) if the image quality needs to be 
maintained at a higher level. If supported on the network, consider also using MPEG-4 multicasting, as the 
bandwidth consumption will be much lower.

Resolutions 60Hz/50Hz
4CIF 30/25 fps

2CIF expanded 30/25 fps
2CIF 30/25 fps
CIF 30/25 fps

QCIF 30/25 fps

Resolutions 60Hz/50Hz
4CIF 25/21 fps

2CIF expanded 25/21 fps
2CIF 30/25 fps
CIF 30/25 fps

QCIF 30/25 fps
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AXIS COMMUNICATIONS<Product Name> Quick User’s Guide

Glossary of Terms
ActiveX - A standard that enables software components to interact with 
one another in a networked environment, regardless of the language(s) 
used to create them. Web browsers may come into contact with ActiveX 
controls, ActiveX documents, and ActiveX scripts. ActiveX controls are 
often downloaded and installed automatically as required. 

AF (Autofocus) - A system by which the camera lens automatically 
focuses on a selected part of the subject. 

Angle - The field of view, relative to a standard lens in a 35mm still 
camera, expressed in degrees, e.g. 30°. For practical purposes, this is the 
area that a lens can cover, where the angle of view is determined by the 
focal length of the lens. A wide-angle lens has a short focal length and 
covers a wider angle of view than standard or telephoto lenses, which 
have longer focal lengths.

ARP (Address Resolution Protocol) - This protocol is used to associate 
an IP address to a hardware MAC address. A request is broadcast on the 
local network to discover the MAC address for an IP address.

ARTPEC (Axis Real Time Picture Encoder) - This chip is used for image 
compression.

ASIC (Application Specific Integrated Circuit) - A circuit designed for 
a specific application, as opposed to a general purpose circuit, such as a 
microprocessor. 

Aspect ratio - A ratio of width to height in images. A common aspect 
ratio used for television screens and computer monitors is 4:3. 
High-definition television (HDTV) uses an aspect ratio of 9:16.

Autoiris (or DC-Iris) - This special type of iris is electrically controlled 
by the camera, to automatically regulate the amount of light allowed to 
enter.

AVI (Audio Video Interleave) - A video format that supports 
simultaneous playback of audio and video. 

Bitmap - A bitmap is a data file representing a rectangular grid of 
pixels. It defines a display space and color for each pixel (or "bit") in the 
display space. This type of image is known as a "raster graphic." GIF's 
and JPEG's are examples of image file types that contain bitmaps. 

Because a bitmap uses this fixed raster method, it cannot easily be 
rescaled without losing definition. Conversely, a vector graphic image 
uses geometrical shapes to represent the image, and can thus be quickly 
rescaled. 

Bit rate - The bit rate (in kbit/s or Mbit/s) is often referred to as speed, 
but actually defines the number of bits/time unit and not distance/time 
unit. 

Bluetooth - Bluetooth is an open standard for wireless transmission of 
voice and data between mobile devices (PCs, handheld computers, 
telephones and printers).

Bonjour - Also known as zero-configuration networking, Bonjour 
enables devices to automatically discover each other on a network, 
without having to enter IP addresses or configure DNS servers. Bonjour 
is a trademark of Apple Computer, Inc.

Broadband - In network engineering terms, this describes transmission 
methods where two or more signals share the same carrier. In more 
popular terminology, broadband is taken to mean high-speed data 
transmission. 

CCD (Charged Coupled Device) - This light-sensitive image device used 
in many digital cameras is a large integrated circuit that contains 
hundreds of thousands of photo-sites (pixels) that convert light energy 
into electronic signals. Its size is measured diagonally and can be 1/4", 
1/3", 1/2" or 2/3". 

CGI (Common Gateway Interface) - A specification for communication 
between a web server and other (CGI) programs. For example, a HTML 
page that contains a form might use a CGI program to process the form 
data once it is submitted.

CIF (Common Intermediate Format) - CIF refers to the analog video 
resolutions 352x288 pixels (PAL) and 352x240 pixels (NTSC). See also 
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Resolution.

Client/Server - Client/server describes the relationship between two 
computer programs in which one program, the client, makes a service 
request from another program, the server, which fulfils the request. 
Typically, multiple client programs share the services of a common 
server program. A web browser is a client program that requests services 
(the sending of web pages or files) from a web server.

CMOS (Complementary Metal Oxide Semiconductor) - A CMOS is a 
widely used type of semiconductor that uses both negative and positive 
circuits. Since only one of the circuit types is on at any given time, 
CMOS chips require less power than chips using just one type of 
transistor. CMOS image sensors also allow processing circuits to be 
included on the same chip, an advantage not possible with CCD sensors, 
which are also much more expensive to produce.

Codec - In communications engineering, a codec is usually a 
coder/decoder. Codecs are used in integrated circuits or chips that 
convert e.g. analog video and audio signals into a digital format for 
transmission. The codec also converts received digital signals back into 
analog format. A codec uses analog-to-digital conversion and 
digital-to-analog conversion in the same chip. 

Codec can also mean compression/decompression, in which case it is 
generally taken to mean an algorithm or computer program for reducing 
the size of large files and programs.

Compression - See Image Compression.

Contrast  - Defines the degree of difference between the lightest and 
darkest parts of an image or video stream.

DC-Iris - This special type of iris is electrically controlled by the 
camera, to automatically regulate the amount of light allowed to enter.

DHCP (Dynamic Host Configuration Protocol) - DHCP is a protocol 
that lets network administrators automate and centrally manage the 
assignment of Internet Protocol (IP) addresses to network devices in a 
network. 

DHCP uses the concept of a "lease" or amount of time that a given IP 
address will be valid for a computer. The lease time can vary, depending 
on how long a user is likely to require the network connection at a 
particular location. 

DHCP also supports static addresses for e.g. computers running web 
servers, which need a permanent IP address.

DNS (Domain Name System) - DNS is used to locate and translate 
Internet domain names into IP (Internet Protocol) addresses. A domain 
name is a meaningful and easy-to-remember name for an Internet 
address. For example the domain name www.example.com is much 
easier to remember than 192.0.34.166. The translation tables for domain 
names are contained in Domain name servers.

Domain Server - Domains can also be used by organizations who wish 
to centralize the management of their (Windows) computers. Each user 
within a domain has an account that usually allows them to log in to 
and use any computer in the domain, although restrictions may also 
apply. The domain server is the server that authenticates the users on the 
network. 

Duplex - See Full-duplex.

Ethernet - Ethernet is the most widely installed local area network 
technology. An Ethernet LAN typically uses special grades of twisted 
pair wires. The most commonly installed Ethernet systems are 10BASE-T 
and 100BASE-T10, which provide transmission speeds up to 10 Mbps 
and 100 Mbps respectively. 

ETRAX (Ethernet Token Ring AXIS) - Axis' own microprocessor.

Factory default settings - These are the settings that originally applied 
for a device when it was first delivered from the factory. If it should 
become necessary to reset a device to its factory default settings, this 
will, for many devices, completely reset any settings that were changed 
by the user. 

Firewall - A firewall works as a barrier between networks, e.g. between 
a Local Area Network and the Internet. The firewall ensures that only 
authorized users are allowed to access the one network from the other. A 
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firewall can be software running on a computer, or it can be a 
standalone hardware device. 

Focal length  - Measured in millimeters, the focal length of a camera 
lens determines the width of the horizontal field of view, which in turn is 
measured in degrees.

FTP (File Transfer Protocol) - An application protocol that uses the 
TCP/IP protocols. It is used to exchange files between computers/devices 
on networks. 

Frame - A frame is a complete video image. In the 2:1 interlaced 
scanning format of the RS-170 and CCIR formats, a frame is made up of 
two separate fields of 262.5 or 312.5 lines interlaced at 60 or 50 Hz to 
form a complete frame, which appears at 30 or 25 Hz. In video cameras 
with a progressive scan, each frame is scanned line-by-line and not 
interlaced; most are also displayed at 30 and 25 Hz.

Frame rate - The frame rate used to describe the frequency at which a 
video stream is updated is measured in frames per second (fps). A higher 
frame rate is advantageous when there is movement in the video stream, 
as it maintains image quality throughout.

Full-duplex - Transmission of data in two directions simultaneously. In 
an audio system this would describe e.g. a telephone systems. 
Half-duplex also provides bi-directional communication, but only in one 
direction at a time, as in a walkie-talkie system. See also Simplex.

Gain - Gain is the amplification factor and the extent to which an 
analog amplifier boosts the strength of a signal. Amplification factors 
are usually expressed in terms of power. The decibel (dB) is the most 
common way of quantifying the gain of an amplifier. 

Gateway - A gateway is a point in a network that acts as an entry point 
to another network. In a corporate network for example, a computer 
server acting as a gateway often also acts as a proxy server and a 
firewall server. A gateway is often associated with both a router, which 
knows where to direct a given packet of data that arrives at the gateway, 
and a switch, which furnishes the actual path in and out of the gateway 
for a given packet.

GIF (Graphics Interchange Format) - GIF is one of the most common 
file formats used for images in web pages. There are two versions of the 
format, 87a and 89a. Version 89a supports animations, i.e. a short 
sequence of images within a single GIF file. A GIF89a can also be 
specified for interlaced presentation.

GOV (Group Of VOPs) - A group of VOP's is the basic unit of an 
MPEG-4 video stream. The GOV contains different types and numbers of 
VOP's (I-VOP's, P-VOP's, etc) as determined by the GOV length and GOV 
structure. See also VOP.

GOV length - The GOV length determines the number of images (VOP's) 
in the GOV structure. See also GOV and VOP.

GOV structure - The GOV structure describes the composition of an 
MPEG-4 video stream, as regards the type of images (I-VOP's or 
P-VOP's) included in the stream, and their internal order. See also GOV 
and VOP.

Half-duplex - See Full-duplex. 

HTML (Hypertext Markup Language) - HTML is the set of "markup" 
symbols or codes inserted in a file intended for display in web browser. 
The markup tells the browser how to display the page's words and 
images for the user.

HTTP (Hypertext Transfer Protocol) - HTTP is the set of rules for 
exchanging files (text, graphic images, sound, video, and other 
multimedia files) on the web. The HTTP protocol runs on top of the 
TCP/IP suite of protocols.

Hub - A (network) hub is used to connect multiple devices to the 
network. The hub transmits all data to all devices connected to it, 
whereas a switch will only transmit the data to the device it is 
specifically intended for.

IEEE 802.11 - A family of standards for wireless LANs. The 802.11 
standard supports 1 or 2 Mbit/s transmission on the 2.4 GHz band. IEEE 
802.11b specifies an 11 Mbit/s data rate on the 2.4 GHz band, while 
802.11a allows up to 54 Mbit/s on the 5 GHz band.
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Image compression - Image compression minimizes the file size (in 
bytes) of an image. Two of the most common compressed image formats 
are JPEG and GIF.

Interlacing - Interlaced video is video captured at 50 pictures (known as 
fields) per second, of which every 2 consecutive fields (at half height) are 
then combined into 1 frame. Interlacing was developed many years ago 
for the analog TV world and is still used widely today. It provides good 
results when viewing motion in standard TV pictures, although there is 
always some degree of distortion in the image.

To view interlaced video on e.g. a computer monitor, the video must first 
be de-interlaced, to produce progressive video, which consists of 
complete images, one after the other, at 25 frames per second. See also 
Progressive scan. 

IP (Internet Protocol) - The Internet Protocol is a method transmitting 
data over a network. Data to be sent is divided into individual and 
completely independent "packets." Each computer (or host) on the 
Internet has at least one address that uniquely identifies it from all 
others, and each data packet contains both the sender's address and the 
receiver's address. 

The Internet Protocol ensures that the data packets all arrive at the 
intended address. As IP is a connectionless protocol, which means that 
there is no established connection between the communication 
end-points, packets can be sent via different routes and do not need to 
arrive at the destination in the correct order. 

Once the data packets have arrived at the correct destination, another 
protocol - Transmission Control Protocol (TCP) - puts them in the right 
order. See also TCP.

IP Address - An IP address is simply an address on an IP network used 
by a computer/device connected to that network. IP addresses allow all 
the connected computers/devices to find each other and to pass data 
back and forth. 

To avoid conflicts, each IP address on any given network must be 
unique. An IP address can be assigned as fixed, so that it does not 
change, or it can be assigned dynamically (and automatically) by DHCP. 

An IP address consists of four groups (or quads) of decimal digits 
separated by periods, e.g. 130.5.5.25. Different parts of the address 
represent different things. Some part will represent the network number 
or address, and some other part will represent the local machine address. 

See also IP (Internet Protocol).

I-VOP - See VOP.

JPEG (Joint Photographic Experts Group) - Together with the GIF file 
format, JPEG is an image file type commonly used on the web. A JPEG 
image is a bitmap, and usually has the file suffix '.jpg' or ".jpeg." When 
creating a JPEG image, it is possible to configure the level of 
compression to use. As the lowest compression (i.e. the highest quality) 
results in the largest file, there is a trade-off between image quality and 
file size. 

kbit/s (kilobits per second) - A measure of the bit rate, i.e. the rate at 
which bits are passing a given point. See also Bit rate.

LAN (Local Area Network) - A LAN is a group of computers and 
associated devices that typically share common resources within a 
limited geographical area.

Linux - Linux is an open source operating system within the Unix 
family. Because of its robustness and availability, Linux has won 
popularity in the open source community and among commercial 
application developers.

MAC address (Media Access Control address) - A MAC address is a 
unique identifier associated with a piece of networking equipment, or 
more specifically, its interface with the network. For example, the 
network card in a computer has its own MAC address. 

Manual iris - This is the opposite to an auto iris, i.e. the camera iris 
must be adjusted manually to regulate the amount of light allowed to 
reach the image sensor.

Mbit/s (Megabits per second) - A measure of the bit rate, i.e. the rate at 
which bits are passing a given point. Commonly used to give the "speed" 
 



AXIS 215 PTZ - Glossary of Terms 
AXIS COMMUNICATIONS<Product Name> Quick User’s Guide

of a network. A LAN might run at 10 or 100 Mbit/s. See also Bit rate.

Monitor - A monitor is very similar to a standard television set, but 
lacks the electronics to pick up regular television signals.

Motion JPEG - Motion JPEG is a simple compression/decompression 
technique for networked video. Latency is low and image quality is 
guaranteed, regardless of movement or complexity of the image. Image 
quality is controlled by adjusting the compression level, which in turn 
provides control over the file size, and thereby the bit rate. 

High-quality individual images from the Motion JPEG stream are easily 
extracted. See also JPEG.

Megapixel - See Pixel.

MPEG (Moving Picture Experts Group) -  The Moving Picture Experts 
Group develops standards for digital video and audio compression. It 
operates under the auspices of the International Organization for 
Standardization (ISO). The MPEG standards are an evolving series, each 
designed for a different purpose.

MPEG-2 - MPEG-2 is the designation for a group of audio and video 
coding standards, and is typically used to encode audio and video for 
broadcast signals, including digital satellite and Cable TV. MPEG-2, with 
some modifications, is also the coding format used by standard 
commercial DVD movies.

MPEG-4 - MPEG-4 is a group of audio and video coding standards and 
related technology. The primary uses for the MPEG-4 standard are web 
(streaming media) and CD distribution, conversational (videophone), and 
broadcast television.

Most of the features included in MPEG-4 are left to individual 
developers to decide whether to implement them or not. This means that 
there are probably no complete implementations of the entire MPEG-4 
set of standards. To deal with this, the standard includes the concept of 
"profiles" and "levels", allowing a specific set of capabilities to be 
defined in a manner appropriate for a subset of applications.

Multicast - Bandwidth-conserving technology that reduces bandwidth 
usage by simultaneously delivering a single stream of information to 
multiple network recipients. 

Multiplexer - A multiplexer is a high-speed switch that provides 
full-screen images from up to 16 analog cameras. Multiplexers can 
playback everything that happened on any one camera with no 
interference from the other cameras on the system.

Network connectivity - The physical (wired or wireless) and logical 
(protocol) connection of a computer network or an individual device to a 
network, such as the Internet or a LAN.

NTSC (National Television System Committee) - NTSC is the television 
and video standard in the United States. NTSC delivers 525 lines at 60 
half-frames/second.

NWay is a telecommunications protocol used to automatically negotiate 
the highest available transmission speed between network devices. The 
NWay protocol is also known as auto-negotiation or auto-sensing.

OEM (Original Equipment Manufacturer) - This is a designation for 
companies that manufacture equipment which is then marketed and sold 
to other companies under their own names.

PAL (Phase Alternating Line) - PAL is the dominant television standard 
in Europe. PAL delivers 625 lines at 50 half-frames/second.

PEM (Privacy Enhanced Mail) - An early standard for securing 
electronic mail. The PEM-format is often used for representing an HTTPS 
certificate or certificate request.

Ping  - Ping is a basic network program used diagnostically to check the 
status of a network host or device. Ping can be used to see if a particular 
network address (IP address or host name) is occupied or not, or if the 
host at that address is responding normally. Ping can be run from e.g. 
the Windows Command prompt or the command line in Unix.

Pixel - A pixel is one of the many tiny dots that make up a digital 
image. The color and intensity of each pixel represents a tiny area of the 
complete image. 

PoE (Power over Ethernet) - Power over Ethernet provides power to a 
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network device via the same cable as used for the network connection. 
This is very useful for IP-Surveillance and remote monitoring 
applications in places where it may be too impractical or expensive to 
power the device from a power outlet. 

PPP (Point-to-Point Protocol) - A protocol that uses a serial interface 
for communication between two network devices. For example, a PC 
connected by a phone line to a server. 

PPTP (Point-to-Point Tunnelling Protocol) - A protocol (set of 
communication rules) that allows corporations to extend their own 
corporate network through private "tunnels" over the public Internet. In 
this way a corporation can effectively use a WAN (Wide Area Network) 
as a large single LAN (Local Area Network). This kind of interconnection 
is known as a virtual private network (VPN). 

Pre/post alarm images - The images from immediately before and after 
an alarm. These images are stored in a buffer for later retrieval.

Progressive scan - Progressive scan, as opposed to interlaced video, 
scans the entire picture, line by line every sixteenth of a second. In other 
words, captured images are not split into separate fields as in interlaced 
scanning. 

Computer monitors do not need interlace to show the picture on the 
screen, but instead show them progressively, on one line at a time in 
perfect order, i.e. 1, 2, 3, 4, 5, 6, 7 etc., so there is virtually no 
"flickering" effect. In a surveillance application, this can be critical when 
viewing detail within a moving image, such as a person running. A 
high-quality monitor is required to get the best from progressive scan. 
See also Interlacing.

Protocol - A special set of rules governing how two entities will 
communicate. Protocols are found at many levels of communication, 
and there are hardware protocols and software protocols. 

Proxy server - In an organization that uses the Internet, a proxy server 
acts as an intermediary between a workstation user and the Internet. 
This provides security, administrative control, and a caching service. 
Any proxy server associated with a gateway server, or part of a gateway 
server, effectively separates the organization’s network from the outside 
network and the local firewall. It is the firewall server that protects the 
network against outside intrusion. 

A proxy server receives requests for Internet services (such as web page 
requests) from many users. If the proxy server is also a cache server, it 
looks in its local cache of previously downloaded web pages. If it finds 
the page, it is returned to the user without forwarding the request to the 
Internet. If the page is not in the cache, the proxy server, acting as a 
client on behalf of the user, uses one of its own IP addresses to request 
the page from another server over the Internet. When the requested page 
is returned, the proxy server forwards it to the user that originally 
requested it. 

PTZ - Pan, tilt and zoom.

P-VOP - See VOP.

Resolution - Image resolution is a measure of how much detail a digital 
image can hold: the greater the resolution, the greater the level of detail. 
Resolution can be specified as the number of pixel-columns (width) by 
the number of pixel-rows (height), e.g. 320x240. 

Alternatively, the total number of pixels (usually in megapixels) in the 
image can be used. In analog systems it is also common to use other 
format designations, such as CIF, QCIF, 4CIF, etc.

RTCP (Real-Time Control Protocol) - RTCP provides support for 
real-time conferencing of groups of any size within an intranet. This 
support includes source identification and support for gateways like 
audio and video bridges as well as multicast-to-unicast translators.

RTCP offers quality-of-service feedback from receivers to the multicast 
group as well as support for the synchronization of different media 
streams. 

RTP (Real-Time Transport Protocol) - RTP is an Internet protocol for 
the transport of real-time data, e.g. audio and video. It can be used for 
media-on-demand as well as interactive services such as Internet 
telephony. 
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RTSP (Real Time Streaming Protocol) - RTSP is a control protocol, and 
a starting point for negotiating transports such as RTP, multicast and 
Unicast, and for negotiating codecs. 

RTSP can be considered a "remote control" for controlling the media 
stream delivered by a media server. RTSP servers typically use RTP as 
the protocol for the actual transport of audio/video data.

Router - A device that determines the next network point to which a 
packet should be forwarded on its way to its final destination. A router 
creates and/or maintains a special routing table that stores information 
on how best to reach certain destinations. A router is sometimes 
included as part of a network switch. See also switch.

Server - In general, a server is a computer program that provides 
services to other computer programs in the same or other computers. A 
computer running a server program is also frequently referred to as a 
server. In practice, the server may contain any number of server and 
client programs. A web server is the computer program that supplies the 
requested HTML pages or files to the client (browser). 

Sharpness - This is the control of fine detail within a picture. This 
feature was originally introduced into color TV sets that used notch filter 
decoders. This filter took away all high frequency detail in the black and 
white region of the picture. The sharpness control attempted to put some 
of that detail back in the picture. Sharpness controls are mostly 
superfluous in today's high-end TVs. The only logical requirement for it 
nowadays is on a VHS machine. 

Simplex - In simplex operation, a network cable or communications 
channel can only send information in one direction.

SMTP (Simple Mail Transfer Protocol) - SMTP is used for sending and 
receiving e-mail. However, as it is "simple," it is limited in its ability to 
queue messages at the receiving end, and is usually used with one of two 
other protocols, POP3 or IMAP. These other protocols allow the user to 
save messages in a server mailbox and download them periodically from 
the server. 

SMTP authentication is an extension of SMTP, whereby the client is 
required to log into the mail server before or during the sending of 
email. It can be used to allow legitimate users to send email while 
denying the service to unauthorized users, such as spammers. 

SNMP (Simple Network Management Protocol) - SNMP forms part of 
the Internet Protocol suite, as defined by the Internet Engineering Task 
Force. The protocol can support monitoring of network-attached devices 
for any conditions that warrant administrative attention.

Sockets - Sockets are a method for communication between a client 
program and a server program over a network. A socket is defined as 
"the endpoint in a connection." Sockets are created and used with a set 
of programming requests or "function calls" sometimes called the 
sockets application programming interface (API). 

SSL/TSL (Secure Socket Layer/Transport Layer Security)

These two protocols (SSL is succeeded by TSL) are cryptographic 
protocols that provide secure communication on a network. SSL is 
commonly used over HTTP to form HTTPS, as used e.g. on the Internet 
for electronic financial transactions. SSL uses public key certificates to 
verify the identity of the server. 

Subnet/subnet mask - A subnet is an identifiably separate part of an 
organization's network. Typically, a subnet may represent all the 
machines at one geographic location, in one building, or on the same 
local area network (LAN). Having an organization's network divided into 
subnets allows it to be connected to the Internet with a single shared 
network address.

The subnet mask is the part of the IP address that tells a network router 
how to find the subnet that the data packet should be delivered to. Using 
a subnet mask saves the router having to handle the entire 32-bit IP 
address; it simply looks at the bits selected by the mask.

Switch - A switch is a network device that connects network segments 
together, and which selects a path for sending a unit of data to its next 
destination. In general, a switch is a simpler and faster mechanism than 
a router, which requires knowledge about the network and how to 
determine the route. Some switches include the router function. See also 
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Router.

TCP (Transmission Control Protocol) - TCP is used along with the 
Internet Protocol (IP) to transmit data as packets between computers 
over the network. While IP takes care of the actual packet delivery, TCP 
keeps track of the individual packets that the communication (e.g. 
requested a web page file) is divided into, and, when all packets have 
arrived at their destination, it reassembles them to re-form the complete 
file.

TCP is a connection-oriented protocol, which means that a connection is 
established between the two end-points and is maintained until the data 
has been successfully exchanged between the communicating 
applications. 

Telnet - Telnet is a simple method with which to access another network 
device, e.g. a computer. The HTTP protocol and the FTP protocols allow 
you to request specific files from remote computers, but do not allow 
you logon as a user of that computer. With Telnet, you log on as a 
regular user with whatever privileges you may have been granted for 
specific applications and data residing on that computer.

TVL (TV Lines) - A method of defining resolutions in analog video.

UDP (User Datagram Protocol) - UDP is a communications protocol 
that offers limited service for exchanging data in a network that uses the 
Internet Protocol (IP). UDP is an alternative to the Transmission Control 
Protocol (TCP). The advantage of UDP is that it is not required to deliver 
all data and may drop network packets when there is e.g. network 
congestion. This is suitable for live video, as there is no point in 
re-transmitting old information that will not be displayed anyway.

Unicast - Communication between a single sender and a single receiver 
over a network. A new connection is established for each new user. 

URL (Uniform Resource Locator) - An "address" on the network.

USB - (Universal Serial Bus) A plug-and-play interface between a 
computer and peripheral devices, e.g. scanners, printers, etc.

Varifocal lens - A varifocal lens provides a wide range of focal lengths, 
as opposed to a lens with a fixed focal length, which only provides one. 

VPN (Virtual Private Network) - This creates a secure "tunnel" between 
the points within the VPN. Only devices with the correct "key" will be 
able to work within the VPN. The VPN network can be within a 
company LAN (Local Area Network), but different sites can also be 
connected over the Internet in a secure way. One common use for VPN 
is for connecting a remote computer to the corporate network, via e.g. a 
direct phone line or via the Internet.

VOP (Video Object Plane) - A VOP is an image frame in an MPEG-4 
video stream. There are several types of VOP:

- An I-VOP is complete image frame.

- A P-VOP codes the differences between images, as long as it is more 
efficient to do so. Otherwise it codes the whole image, which may also 
be a completely new image. 

WAN (Wide-Area-Network) - Similar to a LAN, but on a larger 
geographical scale. 

WLAN (Wireless LAN) - A wireless LAN is a wireless local area 
network that uses radio waves as its carrier: where the network 
connections for end-users are wireless. The main network structure 
usually uses cables.

Web server  - A Web server is a program, which allows Web browsers 
to retrieve files from computers connected to the Internet. The Web 
server listens for requests from Web browsers and upon receiving a 
request for a file sends it back to the browser.

The primary function of a Web server is to serve pages to other remote 
computers; consequently, it needs to be installed on a computer that is 
permanently connected to the Internet. It also controls access to the 
server whilst monitoring and logging server access statistics.

WEP (Wireless Equivalent Privacy) - A wireless security protocol, 
specified in the IEEE 802.11 standard, which is designed to provide a 
wireless local area network (WLAN) with a level of security and privacy 
comparable to that usually expected of a wired LAN. Security is at two 
different levels; 40-bit and 128-bit encryption. The higher the bit 
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number, the more secure the encryption.

WINS (Windows Internet Naming Service) - Part of the Microsoft 
Windows NT Server, WINS manages the association of workstation 
names and locations with IP addresses, without the user or administrator 
having to be involved in each configuration change. 

WPA-PSK (Wi-Fi Protected Access - Pre-Shared Key) - This wireless 
encryption method uses a pre-shared key (PSK) for key management. 
Keys can usually be entered as manual hex values, as hexadecimal 
characters, or as a Passphrase. WPA-PSK provides a greater degree of 
security than WEP.

Zoom lens - A zoom lens can be moved (zoomed) to enlarge the view of 
an object to show more detail. 
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